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1 Change History

Document Release Date Description

Version

V1.3.0 2026-02-28 ® Added the description for importing and exporting cabinet
files.

® Added the description for restoring the device.

® Added the description for automatically enabling the low

latency function.
® Added the description for adding sub-screens.
® Added the description for screen correction.
® Added the description for setting the preset switching effect.

® Added the description for image mosaic.

V1.2.0 2025-09-30 ® Added the description for the device standby mode.

® Added the description for the options of the monitoring

image definition, include smooth and high-definition.
® Added the description for the dual receiving card backup.

® Added the description for screen power-on and power-off

through a remote control.

® Added the description for the function of compatible with
Mac.

® Added the description for the Unico client software.

V1.1.1 2025-08-15 ® Added the description for the OSD function.
® Added the description for the remote control.
® Added the description for the HDR function.

® Updated the Unico web page operations.

V1.1.0 2025-01-06 Added the descriptions of the VX400 Pro, VX600 Pro and
VX1000 Pro.

V1.0.1 2024-12-16 Update Unico-related information.

V1.0.0 2024-12-10 First release
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2 Applicable Products

The content described in the user manual is applicable for the following products:

VX400 Pro, VX600 Pro, VX1000 Pro and VX2000 Pro
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3 Applications

The application diagram takes the VX2000 Pro as an example.

4K Layer 4K Layer

2K Layer 2K Layer 2K Layer

LED Screen

Long Distance

Transmission r 1
- i e

DP |

Audie  Intelligent Central SsDI HDMI
Console  Control Server Source Source  Source

B
Control Cable Optical Fiber Cable ;
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4 Home Screen

This chapter takes the VX2000 Pro as an example.

4.1 Home Screen

Figure 4-1 Home Screen

3840x2160@60

3840x2160@60

1920x

1920x1080@60

3840x2160@60 @ - 100%

Internal

No. Content Description
1 VX2000 Pro The device name
a ® Hold down the knob and BACK
button simultaneously to lock or
unlock the front panel buttons.
® After the buttons are locked, all
the button operations will not
take effect and the & icon will
appear.
o After the buttons are unlocked,
the @ icon will disappear.
192.168.0.10 The device IP address
2 ® Layer 1 Displays the opened layer
® Layer2 information, including the layer
o Layer 3 number, input source, input
resolution and frame rate
3 1920%x1080@60 Displays the resolution and frame
rate of the configured screen.
®-100% The screen brightness

www.novastar.tech
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No. Content Description

4 a The Ethernet port is connected.
o The Ethernet port is not connected.
g ® The Ethernet port is connected

and serves as the backup output

port.

® When the backup icon at the
bottom flashes, there is data

transmission on the port.

5 Synchronization The sync function is enabled and the

synchronization succeeded.

The sync function is not enabled.

The sync function is enabled and the

synchronization is in progress.

The sync function is enabled but the

synchronization failed.

Display control The output is black.

The test pattern is shown.

The output image is displayed.

The output image is frozen.

‘0909090000

Connection The device is connected to the
method control PC via an Ethernet port.
] The device is not connected to the
control PC.
g The device is connected to the
control PC via a USB cable.
USB insertion Go USB drive inserted.
status
O No USB drive inserted.
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4.2 Second Home Screen

4.2.1 OPT Status Screen

When the device is in Video Controller mode, this page may vary according to the device
connected to the OPT port, as well as the OPT 3/4 working mode and the OPT loop mode.

® When a fiber converter is connected to OPT 1/OPT 2, the port is used as an output
connector. The OPT status page displays the connection and backup statuses of the

Ethernet ports on the fiber converter connected to the VX2000 Pro, as shown in Figure 4-2.

Figure 4-2 OPT Status screen

® When a PIXELHUE video processor is connected to OPT 1/0OPT 2, the port is used an input
connector. The OPT status page displays the resolution and frame rate of the accessed OPT
source and the connection and backup statuses of the Ethernet ports on the fiber converter
connected to the VX2000 Pro, as shown in Figure 4-3.

Figure 4-3 OPT input

® When OPT loop mode is enabled, the OPT status page is shown as follows.
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Figure 4-4 OPT Loop

OPT1-1 192 OPT1-2 1920

OPT LOOP

E Note

You can set the working mode of OPT 3 and OPT 4 to Copy or Backup. The OPT status screen
page will display the set working mode.

4.2.2 Fiber Converter Screen

When the device working mode is set to Fiber Converter, OPT 1~4 are all used for input and
Ethernet ports are used for output. OPT 1 and OPT 2 serve as the primary connectors, while
OPT 3 and OPT 4 serve as backup ones. The fiber converter screen page displays the data
transmission status of Ethernet ports on the fiber converter.

Figure 4-5 Fiber converter screen

14| (15| (16| (17| 18| 19 |20

° .: There is data transmission on Ethernet port.

° .: No data transmission on Ethernet ports
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5 Menu Operations

E Note

Knob:

e On the home screen, press the knob to enter the operation menu screen.

e On the operation menu screen, rotate the knob to select a menu item and press the knob to
confirm the selection or enter the submenu.

e When a menu item with parameters is selected, you can rotate the knob to adjust the
parameters. Please note that after the adjustment, you need to press the knob again to
confirm the adjustment.

BACK: Exit the current menu or cancel an operation.

5.1 Screen Brightness

Screen brightness allows you to adjust the LED screen brightness in an eye-friendly way
according to the current ambient illuminance. Besides, the brightness parameters can be saved

to the receiving cards.
Prerequisites
The device is connected to a screen.

Screen Example

Main Menu

Screen Brightness
Screen Configuration
Layer Settings

Input Settings

Preset Settings

Image Mosaic
Display Control
USB Playback
Advanced Settings
System Settings
Factory Reset
Communication

VVVVVVVYVYVYVY
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Operating Procedure

Step 1 On the home screen, press the knob to enter the main menu screen.
Step 2 Select Screen Brightness and press the knob to confirm the selection.

Step 3 Rotate the knob to adjust the brightness value. You can see the adjustment result on the LED

screen in real time. Press the knob to apply the brightness you set when you are satisfied with
it.

5.2 Screen Configuration

Screen configuration allows you to perform the following operations, including configuring the
screen, saving configuration to the receiving card, setting output mapping, setting the LED
screen color and setting the output bit depth.

Figure 5-1 Screen configuration

Screen Configuration

Quick Configuration
Save to RV Card
Mapping

LED Screen Color

Bit Depth

Send Cabinet Config File

5.2.1 Quick Configuration

When the LED screen is a regular one composed of cabinets from the same batch, you can use
the quick configuration function to configure the LED screen.

Prerequisites

® The LED screen must be a regular one.
® The cabinets of the screen must be regular cabinets with the same resolution.

® The following data flow settings are supported. During data flow settings, ensure that each

port's physical connection is along the same direction and downward to the next one.
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® During data flow settings, ensure that Ethernet Port 1 is at the beginning of the actual

physical connection.

Figure 5-2 Data flow

2 S NS U e

Notes

® Cabinets loaded by Ethernet port 1 = cabinets loaded by Ethernet port 2 = ... = cabinets

loaded by Ethernet port n ("n" represents the maximum port number.)

® The number of cabinets loaded by each Ethernet port must be an integer multiple of

Cabinet Row Qty or Cabinet Column Qty of the screen.

® The total pixels of the cabinets loaded by Ethernet port 1 cannot exceed 650,000.

Screen Example

Quick Configuration

Cabinet Row Qty
Cabinet Column Qty
Port 1 Cabinet Qty
Data Flow (Front View)

The top edges of the areas loaded by all Ethernet ports
must be aligned when turning on the low latency

function. Please pay attention to the data flow or offset.

Operating Procedure

Step 1 On the main menu screen, rotate the knob to go to Screen Configuration > Quick

Configuration to enter the quick configuration screen.

Step 2 Set Cabinet Row Qty and Cabinet Column Qty according to the cabinets' actual row and

column quantities.

Step 3 Rotate the knob to select Port 1 Cabinet Qty to set the quantity of the cabinets loaded by
Ethernet port 1.

Step 4 Rotate the knob to select Data Flow (Front View) and press the knob to confirm. Select a

physical connection for the cabinets.
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During data flow settings, you can see the result on the LED screen in real-time. If the entire
screen displays content correctly, that is, no overlapping or repetition, press the knob to save

the settings.

5.2.2 Save to RV Card

After the screen configuration information is sent to the receiving card, you can save the
configuration to the card by using this function so that the configuration data will not be lost

after a power failure.

Screen Example

Screen Configuration

Quick Configuration
Save to RV Card
Mapping

LED Screen Color
Bit Depth

Send Cabinet Config File

Operating Procedure

On the main menu screen, go to Screen Configuration > Save to RV Card and press the knob

to confirm.

5.2.3 Mapping

Mapping is used to show the relations between the cabinets of the LED screen and the sending

devices so that you can view or check the connections between the cabinets.

Notes

The receiving cards that are connected to the device must support the Mapping function. For
the supported models of the receiving cards, please visit our official website at

www.novastar.tech.
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Screen Example

Screen Configuration

Quick Configuration
Save to RV Card
Mapping

LED Screen Color

Bit Depth

Send Cabinet Config File

Operating Procedure

On the main menu screen, go to Screen Configuration > Mapping and turn on the function.

Figure 5-3 Mapping

Example: S:01 stands for the sending card number, P:01 stands for the Ethernet port number
and #001 stands for the cabinet number.

5.2.4 LED Screen Color

This function allows you to adjust the color temperature and Gamma value of the LED screen to

make the images displayed on the screen more clear and vivid.
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Screen Example

LED Screen Color

Gamma

2.8

Color Temperature Mode Standard
Color Temperature (K) 6500

Operating Procedure

On the main menu screen, go to Screen Configuration > LED Screen Color to enter the screen

color settings screen.

® Select Gamma and press the knob to confirm. Rotate the knob to adjust the Gamma value

and press the knob to confirm when you are satisfied with it.

® Rotate the knob to select Color Temperature Mode and press the knob to confirm. Rotate

the knob to adjust the temperature mode, including Standard, Cool, Warm and Custom,

and then press the knob to confirm when you are satisfied with it.

When Custom is selected, you can customize the color temperature value.

® Perform the following operations as needed.

- Save: Save the LED screen color parameters to the receiving card, so that the

parameters will be not be lost after power failure.

- Reset: Reset all parameters to factory defaults.

Parameter Descriptions

Parameter Description
Gamma Adjust the image distortion degree from the input to output. The greater the value is,
the more distorted the image will be.
The value ranges from 0.25 to 4.00 and defaults to 2.8.
Color Adjust the cool or warm degree of images displayed on the LED screen. When
Temperature Custom is selected, you can customize the color temperature value.
Mode
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5.2.5 Set Output Bit Depth

Notes

When you use the HDR function, setting output bit depth to 10bit is required to achieve optimal
display effect.

Screen Example

Screen Configuration

Quick Configuration
Saveto RV Card
Mapping

LED Screen Color
Bit Depth

Send Cabinet Config File

Parameter Descriptions

Parameter Description

Bit Depth Set the output bit depth.

The supported options include 8bit and 10bit.

5.2.6 Send Cabinet Configuration Files

You can send the pre-stored configuration file to the receiving card to unify display effect on all
cabinets with no need to perform operations on the control PC, realizing convenient debugging.
The cabinet file can be exported and imported to other devices, facilitating multi-device control

and on-site maintenance.
Prerequisites

® Before importing the cabinet file, you have placed the .rcfgx or .NCP file in the root directory
of the USB drive, and inserted the USB drive in to the USB 2.0 port on the device rear panel.
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® Before exporting the cabinet file, you have inserted the USB drive in to the USB 2.0 port on
the device rear panel.

Notes

® 64 configuration files can be saved, with a total capacity less than 500 MB.

® |t is recommended that the size and shape of the cabinets to be configured are the same, as
well as use the receiving cards of the same model.

Screen Example

Send Cabinet Config File

Cabinet Library
Import
Export

Import Cabinet Configuration Files

You can import the cabinet file to the device cabinet library via the following methods.
® Method I: Import the file via Unico.

® Method II: Import the file via USB drive.

Step 1 On the Send Cabinet Config File screen, rotate the knob to select Import and press the knob
to confirm.

Step 2 Rotate the knob to select the desired file and press the knob to confirm. In the popup dialog
box, select Export or Export All.

Send Cabinet Configuration Files

You can send the cabinet file to the receiving card via the following methods.

® Method I: Send the file via USB drive.
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On the Import screen, rotate the knob to select the desired file and press the knob to
confirm. In the popup dialog box, select Send to send the selected file to the receiving card.

This file will not be imported to the cabinet library.

® Method II: Select the desired file in the cabinet library and send it.

Step 1 On the Send Cabinet Config File screen, rotate the knob to select Cabinet Library and press

the knob to confirm.
Step 2 Rotate the file to select the file and press the knob to confirm.
Step 3 In the popup dialog box, select Send and press the knob to confirm.

Step 4 In the popup dialog box, select OK and wait for sending.

Export Cabinet Configuration Files

On the Send Cabinet Config File screen, rotate the knob to select Export. In the popup dialog

box, select OK to export all cabinet files in the cabinet library to the inserted USB drive.

Delete Files in Cabinet Library

You can delete the file in the cabinet library via the following methods.

® Method I: Delete a single file.

Step 1 On the Send Cabinet Config File screen, rotate the knob to select Cabinet Library and press

the knob to confirm.

Step 2 On the Cabinet Library, rotate the knob to select the desired file and press the knob to

confirm. In the popup dialog box, select Delete to delete the selected file.

® Method II: Clear all files in the cabinet library.

On the Send Cabinet Config File, rotate the knob to select Clear Cabinet Library and press
the knob to confirm. In the popup dialog box, select OK.
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5.3 Layer Settings

5.3.1 Add Layers

Notes

The maximum number of layers that can be added depends on the connected device.

Device Model Number of Supported Layers (2Kx1K)
VX400 Pro 6

VX600 Pro

VX1000 Pro

VX2000 Pro 12

Screen Example

Layer Settings Layer Settings

Layer Settings Layer No. Layer 1 (4K)
OSD Settings Layer Status °
Input Source HDMI 1 (4K)
Scaling Mode Full Screen

Disable All H Width 3840

V Height 2160
Initial X

Initial Y

Priority

Input Crop

3D

Operating Procedure

Step 1 On the home screen, press the knob to enter the main menu screen.
Step 2 Rotate the knob to select Layer Settings and press the knob to enter the layer settings screen.

Step 3 Rotate the knob to select Layer Settings and press the knob to enter the layer properties
screen.

Step 4 Rotate the knob to select Layer No. and press the knob to display the layer list.
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Step 5
Step 6
Step 7

Step 8

Step 9

B Note

e In the layer list, both the current opened layers and the layers to be opened are displayed.
e Layer name displayed in the layer list: Opened layer: Layer n (capacity), unopened layer: Layer

n, and “n” represents the layer number.

Rotate the knob to select the desired layer number and press the knob to confirm.
Rotate the knob to select Layer Status and press the knob to turn on the switch.
Rotate the knob to select Input Source and select the desired input source for the layer.

Rotate the knob to select other layer parameters and set them if needed. The layer parameter

descriptions are shown in Set Layer Properties.

Figure 5-5 Layer parameter descriptions

LED Screen
Initial Y

o
Initial X ‘

[ )
o
o0
o
=
SN
+—
s

2
[}
=
| >

H Width (1920)

Rotate the knob to select Priority and set the layer priority.

The greater the priority number is, the higher priority the layer has.

B Note

On the Layer Settings screen, rotate the knob to select Disable All and press the knob to disable

all layers.
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5.3.2 Set Layer Properties

Parameter Descriptions

Table 5-1 Layer properties

Menu Description
Layer No. The layer number
Layer Status Open or close the layer

a Note

By default, layer 1 is opened and uses the first input source.

Input Source

Select an input source for the current layer.

E Note

Press an input source button in the SOURCE area on the device front panel

to quickly select an input source for the layer.

Scaling Mode

The layer supports the following three scaling modes.
® Full Screen: The layer image fills the whole screen.

® Pixel to Pixel: The layer image is not scaled but displayed in the original
size of the input source or the cropped source.

® Custom: Customize the layer size and the output image is scaled

according to the layer size.

H Width

Set the layer size in the horizontal direction.

The width value ranges from 64 to 131070.

V Height

Set the layer size in the vertical direction.

The height value ranges from 64 to 131070.

Initial X

Set the horizontal distance between the top left corner of the layer and the
top left corner of the screen.

The value ranges from -250000 to 248080.

Initial Y

Set the vertical distance between the top left corner of the layer and the top

left corner of the screen.

The value ranges from -250000 to 248080.

Priority

The layer priority
® Up: Bring the selected layer forward.

® Down: Send the selected layer backward.
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Menu Description

® Top: Bring the selected layer to the front.

® Bottom: Send the selected layer to the back.

Input Crop Crop the input source image and display the cropped part on full screen.
® Status: Turn on or turn off the function.

® H Width: The size of the copped part in the horizontal direction

® V Height: The size of the copped part in the vertical direction.

® |nitial X: Set the start position for the cropping in the horizontal direction.
The value defaults to 0.

® |nitial Y: Set the start position for the cropping in the vertical direction.
The value defaults to 0.

3D Turn on or turn off the function.
e On: @
e Off: (OB

5.3.3 Input Crop

This function allows you to crop the input source image and make the cropped part display on

full screen.
Prerequisites

A fine signal is connected to the input connector.
Notes

® The status and capacity of the cropped source remain consistent with the original one.

® The input cropping and 3D functions cannot be enabled at the same time.
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Screen Example

Input Crop

Status [ Resolution:
H Width 1920 3840x2160

VHeight 1080 E
Initial X 0

Initial Y 0

Operating Procedure

Step 1 On the Layer Settings screen, rotate the knob to select Input Source and press the knob to

display the input source list.
Step 2 Rotate the knob to select the desired input source and press the knob to confirm.

Step 3 Rotate the knob to select Input Crop and press the knob to enter the input source cropping
screen.

Step 4 Select Status and press the knob to turn on the function.

Step 5 Rotate the knob to configure the cropping parameters and set them if needed. The cropping

parameter descriptions are shown in Set Layer Properties and Figure 5-5.

Figure 5-6 Input crop effect

xﬁ;/ -.‘.

Input Source: 1920x1080@60Hz Layer Size: 1920x1080

www.novastar.tech 27



NOVASTAR VX Pro Series All-in-One Controller User Manual

5.4 OSD Settings

Both the text OSD and image OSD are supported. For the text OSD, four components are
supported, including the static text OSD, dynamic text OSD, weather OSD and time OSD.

Prerequisites

® Before sending a text OSD to an LED screen via device, make sure that you have configured
a text OSD preset in Unico.

® Before sending an image OSD to an LED screen via device, make sure that you have
imported images in Unico, or imported images saved in a USB drive which is installed into

the USB port on the device rear panel.
Notes

® The related parameters of a text OSD cannot be set via device LCD screen, and you need to

set them in Unico in advance.

® Scaling and cropping an image OSD is not supported via device LCD screen, and you need to

set the scaling ratio and cropped image after you have imported images in Unico.
® The OSD locates at the top and its priority cannot be adjusted.
® The text OSD and image OSD cannot be enabled together.

® The OSD function and remote control function cannot be enabled together.
Screen Example

Figure 5-7 Text OSDs

0OSD Settings
Status e
Type Text
Select OSD Preset 1
Initial X 723
Initial Y 329
H Width 540

V Height 200
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Figure 5-8 Image OSDs

0OSD Settings
Status
Type
Select OSD
Initial X
Initial Y
H Width
V Height

Import Image

Operating Procedure

Step 1 On the Layer Settings screen, rotate the knob to select OSD Settings and press the knob to
enter the OSD settings screen.

Step 2 Rotate the knot to select Status and press the knob to turn on the switch to enable the OSD
function.

Step 3 Set the OSD type. The supported options include Text and Image.

® Text: You have configured a text OSD preset in Unico.

® Image: You have imported images in Unico or imported images saved in a USB drive.

Step 4 (Optional) Rotate the knob to set the initial X and initial Y of an image OSD, and press the knob

to confirm.

E Note

If the configured OSD parameters are changed, you need to click Apply in Unico to resend the
OSD parameters.

OSD Type Descriptions

OSD Type Description

Text OSD ® Up to four text OSD presets are supported, and the preset 1 is selected by
default. The quantity of the text components are as follows.

— Static text OSD: 10
-  Weather OSD: 2

— Time OSD: 2

~  Dynamic text OSD: 1
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OSD Type Description

® Does not support settings of the size and position of a text OSD.

E Note

The dynamic text OSD and other text components cannot be used together.

Image OSD ® Image gallery capacity: 75 MB
® Supported image OSD formats: PNG/JPG/JPEG/BMP
® Width and height limitations of a single image:

— VX400 Pro/VX600 Pro/VX1000 Pro: Max width x Max height <
4096%1080, max width: 10240 pixels, max height: 8192 pixels

— VX2000 Pro: Max width x Max height < 4096x2160, max width: 16384
pixels, max height: 8192

Note: If the max width and height limitations are exceeded, you need to
scale or crop the image in Unico, and the width and height of the cropped

should be greater than 64 pixels.
® Supports setting of the image OSD position.
® Does not support setting of the image OSD size.

® Does not support setting of the image OSD opacity.

5.5 OPT Source Descriptions

The device can receive long-distance video sources via OPT ports.
® The OPT source can be provide via a switcher or fiber extender.

® OPT 1 and OPT 2 match the silkscreens marked on the device rear panel. If two SL sources
are received via OPT 1, both OPT 1-1 and OPT 1-2 have an input source respectively; if a DL

source is received via OPT 1, only OPT 1-1 has an input source.

The relationship between the OPT source and OPT port is as follows.

Table 5-2 OPT source description

Product Model Description

VX400 Pro Self-adaptive OPT 1 for video input

VX600 Pro You can select OPT 1-1 or OPT 1-2 source from
the input source list displayed on the device LCD

VX1000 Pro screen.

VX2000 Pro Self-adaptive OPT 1/0OPT 2 for video input

You can select OPT 1-1, OPT 1-2, OPT 2-1 or OPT

2-2 source from the input source list displayed on
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Product Model Description

the device LCD screen.

Figure 5-9 OPT input sources

LED Screen

Long Distance
Transmission

PIXELHUE Switcher

5.6 Input Settings

The input settings allow you to switch the input connector capacity, set input resolution and
InfoFrame override parameters, as well as configure mosaic sources.

Figure 5-10 Input settings

Input Settings

Input Source HDMI 1
Capacity 4K
Input Resolution  3840%x2160@60Hz
InfoFrame Override >
MQOSAIC >
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5.6.1 Switch Connector Capacity

Switch the input connector capacity to allow the device to calculate the number of layers that

can be added based on the capacity.
Prerequisites
You have selected an input source.
Notes
Changing the connector capacity of the OPT source is not supported.

Screen Example

Input Settings

Input Source
Capacity

Input Resolution
InfoFrame Override
MOSAIC

Operating Procedure

Step 1 On the input settings screen, rotate the knob to select Input Source and press the knob to

display the input source list.
Step 2 Rotate the knob to select the desired input source and press the knob to confirm.
Step 3 Rotate the knob to select Capacity and press the knob to display the capacity list.

Table 5-3 Connector capacity limitations

Connector Capacity Description

SL ® Standard resolution: 1920x1080@60Hz
® Custom max width: 2048 (2048x1080@60Hz)
® Custom max height: 2048 (1080x2048@60Hz)

www.novastar.tech 32



NOVASTAR VX Pro Series All-in-One Controller User Manual

Connector Capacity Description

DL ® Standard resolution: 3840x1080@60Hz/3840%2160@30Hz
® Custom max width: 4096 (4096x1080@60Hz)
® Custom max height: 3840 (1080x3840@60Hz)

4K ® Standard resolution: 4096x2160@60Hz/8192x2160@30Hz
® Custom max width: 8192 (8192x1080@60Hz)
® Custom max height: 8188 (1080x8188@60Hz)

E Note

If the resolution of an input source is larger than the max width limit of the connector capacity,
you need to switch the connector capacity to ensure that the input source can be processed

normally.

Step 4 Rotate the knob to select the target capacity and press the knob to confirm.

5.6.2 Set Input Resolution

Set the input resolution and frame rate. The options include Standard and Custom.

Prerequisites

® The front-end device outputs the video source from the graphics card.

® You have selected an HDMI or DP source. SDI does not support this function.

Screen Example

Figure 5-11 Standard resolution

Standard
Resolution 3840x2160
Frame Rate 60

Input Resolution
Current Resclution 3840x2160@60Hz
Standard
Custom
Import EDID
Export EDID

Display Resolution Details ®

Apply

Compatible with Mac
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Figure 5-12 Custom resolution

Input Resolution
Current Resolution 3840x2160@60Hz
Standard
Custom
Import EDID
Export EDID

Custom
Width
Height

Frame Rate

Compatible with Mac

Operating Procedure (Standard Res)

Step 1 On the input settings screen, select the desired input source and press the knob to confirm.
Step 2 On the input resolution settings screen, select Standard.
Step 3 Rotate the knob to select Resolution, and press the knob to show the resolution list.

Step 4 Rotate the knob to select the desired resolution from the list and then press the knob to

confirm.

Step 5 Rotate the knob to select the desired frame rate from the list and then press the knob to

confirm.

Step 6 (Optional) Rotate the knob to select Display Resolution Details and press the knob to turn on
the switch.

Step 7 Rotate the knob to select Apply and press the knob to complete the standard resolution

settings.

Operating Procedure (Custom Res)

Step 1 On the input settings screen, select the desired input source and press the knob to confirm.
Step 2 On the input resolution settings screen, select Custom.

Step 3 Rotate the knob to select Width and press the knob to confirm. Rotate the knob again to select
the desired width and press the knob to confirm.

Step 4 Rotate the knob to select Height and press the knob to confirm. Rotate the knob again to select
the desired height and press the knob to confirm.

Step 5 Rotate the knob to select Frame Rate and press the knob to show the frame list. Rotate the

knob again to select the desired frame rate and press the knob to confirm.
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Step 6 Rotate the knob to select Apply and press the knob to complete the custom resolution settings.

5.6.3 Import and Export EDID

If you encounter a compatibility problem with an input connector, you can resolve it by
importing a compatible EDID file into the device. You can also export an EDID file from the

device and providing it to other devices or input connectors.

Prerequisites

e Before importing the EDID file, you have saved the file (.bin and .dat) to the root directory in
an USB drive and inserted it into the device USB port.

® Before exporting the EDID file, you have inserted an USB drive into the device USB port.

® You have selected an accessed input source. SDI connector does support this function.

Notes

® Each input connector supports importing one EDID file only.

® Once the EDID file is imported, the input connector will recognize and apply the parameters

from the file.

Screen Example

Input Resolution
Current Resolution 3840x2160@60Hz
Standard
Custom
Import EDID
Export EDID

Compatible with Mac

Operating Procedure (Import EDID)

Step 1 On the input resolution settings screen, rotate the knob to select Import EDID and press the

knob to enter the EDID file list screen.
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Step 2 Select the desired file and press the knob to confirm

Step 3 In the popup dialog, select OK to import the EDID file.
Operating Procedure (Export EDID)

Step 1 On the input resolution settings screen, rotate the knob to select Export EDID and press the
knob to enter the EDID file exporting screen.

Step 2 Select the file format (.bin or .dat) and press the knob to confirm.

Step 3 Select Apply to apply the parameters saved in the file.

E Note

If you need to modify the content of an imported EDID file, just modify it and then re-import it to

overwrite the original one.

5.6.4 Compatible with Mac

When the device is incompatible with the EDID of a Mac system, you may activate this feature

to resolve the issue.

Screen Example

Input Resolution
Current Resolution 3840x2160@60Hz
Standard
Custom
Import EDID
Export EDID

Compatible with Mac

Parameter Descriptions

Parameter Description
Compatible with Mac Turn on or turn off the function.
e @:0On
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Parameter Description

o (I: Off

5.6.5 Configure InfoFrame Override Parameters

Set the InfoFrame override parameters for the input source, allowing the device to use them

during calculations. This won't alter the input source's original parameter values.
Parameter Description
You have selected an HDMI or DP source. SDI does not support this function.

Screen Example

InfoFrame Override

Color/Sample (N/A) From Input
Quantization Range (N/A) From Input
Bit Depth (N/A) From Input
Gamut (N/A) From Input

Operating Procedure

Step 1 On the input settings page, rotate the knob to select InfoFrame Override and press the knob
to enter the corresponding screen.

Step 2 Rotate the knob to set the color/sample of the input source and press the knob to confirm.
Step 3 Rotate the knob to set the quantization range of the input source and press the knob to

confirm.

Parameter Descriptions

Menu Description

Color/Sample The sampling format of the input

The supported options include RGB 4:4:4, YCbCr 4:2:2, YCbCr 4:4:4 and
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Menu

Description

From Input.

Quantization Range

The quantization range of the input

The supported options include From Input, Limited and Full.

Bit Depth The bit depth of the input, i.e., the binary digits to represent a single color
The supported options include From Input, 8bit, 10bit and 12bit.
Gamut The gamut standard of the input

The supported options include Rec.601, Rec.709, DCI-P3(D65), Rec.2020

and From Input.

E Note

Select From Input and the device will read the attribute values that come with the input source.

5.6.6 Configure Mosaic Sources

Both HDMI and OPT sources support mosaicing.

Notes

® Only the VX2000 Pro supports this function.

® Only the input sources of the same connector type support mosaicing, and the frame rates

of sub-source must be the same.

Screen Example

MOSAIC
Source Type
Layout
Width
Height

HDMI 3 HDMI 4

Mosaic Size: 3840x1080

Reset

HDMI 1.3

1920
1080

Apply

Make sure that frame rate of each source must be the same,
otherwise issues such as mosaic image tearing may occur
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Operating Procedure

Step 1 On the input settings screen, rotate the knob to select MOSAIC and press the knob to enter the

mosaic source settings screen.
Step 2 Rotate the knob to select Source Type and press the knob to confirm.
Step 3 Select the desired mosaic layout.
Step 4 Set Width and Height for each mosaic area.

® [f the input source width or height is less than the width or height value you set, the blank

area will be filled with solid black.

® |f the input source width or height is larger than the width or height value you set, the input
source image will be cropped. The cropping takes the top left corner of the input source
image as the reference point and then crops the image according to the set width and

height values.

® The total width and height of the mosaic source will be displayed.

Step 5 Rotate the knob to select the mosaic layout area and press the knob to select sub-sources of

each mosaic area.

Step 6 Rotate the knob to select Apply to make the settings take effect; otherwise, select Reset to

reset the settings to defaults.

Parameter Descriptions

Parameter Description

Source type The connector type of the sub sources

The supported options include HDMI 2.0, HDMI 1.3 or OPT.

E Note

Each OPT port supports transmission of 2x SL or 1x DL source.

Layout The mosaic layout

The layout varies depending on the source type.

® For HDMI 2.0, three layouts are supported: " .", [I and "

® For HDMI 1.3, eight layouts are supported: ., [I, :, l], =,
AL

® For OPT, eight layouts are supported: . [I : l] = ﬂ
T -—
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Parameter Description

Width The width of the individual mosaic area

Default value: 1920 pixels

Height The height of the individual mosaic area

Default value: 1080 pixels

Mosaic Size The size of the mosaic source

® Max. width: 8192 pixels

® Max. height: 8192 pixels

® Max. width and height: 4096x2160

E Note

The mosaic source capacity depends on the max capacity and number of sub-sources, that is, the

capacity of a mosaic source composed of two DL sub-sources or SL+4K sub-sources is 4K.

5.7 Preset Settings

A preset is a set of parameters that save the layer and layer-related information. Up to 256
user-defined presets are supported. After a preset is saved, you can load the preset simply by
its name. The preset operations include Save, Load and Delete.

Screen Example

Figure 5-13 Preset settings

Preset Settings
[001 Preset 1
002 Preset 2
003| Preset 3
Preset 4
005 Preset 5

Preset 6
Preset 7
Preset 8
Preset 9
010 Preset 10
011 Preset 11

5.7.1 Save Presets

After the layer settings, you can save those settings as a preset.
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Screen Example

Preset Settings
[007 Preset 1
002 Preset 2
003| Preset 3
Preset &4
Preset 5

Preset é
/| Preset 7
008 Preset 8
Preset9
010 Preset 10
011 Preset 11

Operating Procedure

Preset Settings
(0017 Preset 1
]

[i]
0

[4]
009 Preset 9

D10 Preset 10
011 Preset 11

Step 1 On the preset settings screen, rotate the knob to select a preset.

Step 2 Press the knob to open the preset operations window.

Step 3 Rotate the knob to select Save and press the knob to save the layer settings to this preset.

After a preset is saved, the preset status on the right side changes to Saved.

5.7.2 Load Presets

This operation allows you to send a saved preset to an LED screen.

Screen Example

Preset Settings
[007 Preset 1
002 Preset 2
Preset3
Preset &4
005| Preset 5

Preset &
Preset7
008 Preset 8
Preset9
010 Preset 10
011 Preset 11

Operating Procedure

Preset Settings
[001 Preset 1
002

0

0

008
009 Preset 9

010/ Preset 10
011 Preset 11

Step 1 On the preset settings screen, rotate the knob to select a saved preset.
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Step 2 Press the knob to open the preset operations window.
Step 3 Rotate the knob to select Load and press the knob to load the preset.

After a preset is loaded, the preset status on the right side changes to In Use.

E Note

Press the PRESET button on the front panel to quickly enter the preset setting screen. You can
press a number button to quickly load the corresponding preset.

5.7.3 Delete Presets

This operation allows you to clear the data saved in the preset. The preset name will not be
cleared.

Screen Example

Preset Settings
[007 Preset 1
002 Preset 2
003| Preset 3
Preset 4
005 Preset 5

Preset Settings

[007) Preset 1
0

Preset 6
Preset 7
Preset 8
Preset ¢

Preset 10
011 Preset 11

[o]

0
009 Preset 9

010 Preset 10
011 Preset 11

Operating Procedure

Step 1 On the preset settings screen, rotate the knob to select a saved preset.
Step 2 Press the knob to open the preset operations window.
Step 3 Rotate the knob to select Delete and press the knob to open a confirmation window.

Step 4 Rotate the knob to select Yes and press the knob to delete the preset.
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5.8 Image Mosaic

When the LED screen cannot be loaded by a single device, you can mosaic multiple devices to
expand the system overall loading capacity. This allows to drive a screen with larger physical

areas and higher total pixels.
Connection Method

Figure 5-14 VX2000 Pro

LED Screen

=
Video Source

VX2000 Pro-2

LED Screen

VX1000 Pro-2

Prerequisites

None
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Notes

® |t is advisable to use devices of the same type to load the screen. Otherwise, there will be

seams between mosaic screens.

® To ensure image sync between mosaic screens, the system will use the layer 1 source as the
sync source by default after you enable the image mosaic function. Please ensure that the
signal source in use is stable and reliable.

® After enabling the image mosaic function, any changes made to layer 1 parameters will

cause this function to be automatically disabled.

Screen Example

Image Mosaic

Image Mosaic

Total H Pixels
Total V Pixels
Load Area Width
Load Area Height
Load Area Initial X
Load Area Initial Y

Operating Procedure

Step 1 On the main menu screen, rotate the knob to select Image Mosaic and press the knob to enter

the image mosaic settings screen.

Step 2 Rotate the knob to select Image Mosaic and press the knob to confirm. Rotate the knob again

to select On and press the knob to confirm.
Step 3 Set the mosaic-related parameters for each device.

® Total H Pixels: The number of pixels in the horizontal direction of the LED screen
® Total V Pixels: The number of pixels in the vertical direction of the LED screen

® | oad Area Width: The number of pixels in the horizontal direction of the area loaded by the

current device

® |oad Area Height: The number of pixels in the vertical direction of the area loaded by the

current device
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® | oad Area Initial X: The initial horizontal coordinate of the top-left corner of the area loaded

by the current device. The unit is pixel.

® | oad Area Initial X: The initial vertical coordinate of the top-left corner of the area loaded by

the current device. The unit is pixel.

5.9 Display Control

Notes
If the freeze or FTB function is turned on, the test pattern function is unavailable.

Screen Example

Display Control

Normal

Freeze

FTB

Test Pattern

Preset Trans Effect
Preset Trans Duration

Output Color

Parameter Descriptions

Menu Sub-Menu Description
Normal - Display the content of the current input source.
Freeze - Freeze the current frame of the output image.
FTB - Make the output image fade to black.
Test Pattern | Pure Color The pure color test pattern
Gradient The gradient test pattern
Grid The grid test pattern
Brightness The brightness of the test pattern
Spacing Level Set the spacing between different color areas.
If a multi-color test pattern is selected, this parameter is
available.
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Menu Sub-Menu Description

Spacing (px) Set the spacing between the lines.

If a grid test pattern is selected, this parameter is available.

Line Width Set the width of the grid lines.

If a grid test pattern is selected, this parameter is available.

Speed Set the moving speed of the lines.

If a grid test pattern is selected, this parameter is available.

Preset Trans | - Set the preset switching effect. The supported options include
Effect Cut and Fade.

® Cut: Switch one preset to another with no transition effect.
® Fade: Switch one preset to another with a fade effect.

After selecting Fade effect, you can set the transition duration.

The value ranges from 1s to 3s and it defaults to 2s.

E Note

® The fade effect takes effect on presets with less than 7x SL
layers only.

® Only the VX2000 Pro supports setting of the preset switching
effect.

Output Brightness The shading of lights in the image

Color Adjust the brightness value either as a whole or individually

adjust the RGB components.

Contrast The ratio of the luminance of the brightest color to that of the

darkest color

Adjust the contrast value either as a whole or individually adjust
the RGB components.

Saturation The color purity of the image

The higher the value, the more vivid the color.

Hue The relative degree of how bright or dark the image is

5.10 USB Playback

Play images or videos saved in a USB drive and configure the playback parameters. A USB

source can be used as a layer source.

The models of devices that support USB playback and the corresponding output resolutions for

USB sources are listed below.
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Device Model USB Source Resolution
VX400 Pro 1920x1080@60Hz
VX600 Pro

VX1000 Pro

VX2000 Pro 3840%2160@60Hz

E Note

Press the desired layer button in the LAYER area on the device front panel and then press the U-
DISK button to use a USB source to open a layer.

5.10.1 USB Player

Prerequisites

A USB drive has been inserted and recognized in the U-DISK connector on the front panel.
Notes

Up to 128 files can be displayed in the playlist and the size of each file cannot exceed 128 GB.

Screen Example

USB Playback
USB Player
Playback Settings

USB Player
1. Media 01.png
2. Media 02.png
3. Media 03.mp4
4. Media 04.mp4

Prompt: Afile name on the USB drive cannot
exceed 128 characters.

Unplayed

Operating Procedure

Step 1 On the main menu screen, go to USB Playback > USB Player to enter the USB player screen.
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Step 2 Rotate the knob to select the desired the file and press the knob to play the file or stop the
playback.

The items displayed on this screen are as follows.
® Media files in compatible formats
® The playback mode

® The playback status

5.10.2 Playback Settings

Configure the playback-related parameters.

Screen Example

USB Playback Playback Settings
USB Player Playback Mode

Playback Settings File Type All
Image Playback Duration (s) 5

Prompt: Afile name on the USB drive cannot Image Trans Effect Ripple
exceed 128 characters.

Image Trans Duration (s)
Auto Playback

Resume Playback
Volume

Limitations

® Single-partition USB drive supported
® File system: NTFS, FAT32 and exFAT
® Max. width and height of media files
Width: 3840 pixels, height: 2160 pixels
® Picture format: jpg, jpeg, png and bmp
® Decoded image resolution: 3840x2160 or lower
® Video format: mp4, mkv, mov, avi, flv, m4v, mpg, mpeg, ts
® Video coding: H.264, H.265, MPEG-2, MPEG-4
® Max. video frame rate:

H.264: 3840%x2160@30fps, H.265: 3840x2160@60fps
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MPEG-2/MPEG-4: 1920%1080@60fps
® Max bitrate:

H.264/H.265: 100Mbps

MPEG-2/MPEG-4: 50Mbps
® Audio coding: AAC, AC3, DTS, MP3, DVD, DVD_LPCM, MP2, OPUS
® Audio sampling rate:

opus: 24kHz, 48kHz

Other formats: 22.05kHz to 94kHz

Parameter Descriptions

Parameter Description

Playback Mode The playback mode of the file

® Loop: Play the files in the playlist in order. Once the playback of the last file
is completed, replay the first file.

® Play in Order: Play the files in the playlist in order. Once the playback of the
last file is completed, the screen will display a black image and the playback

will stop.

® Repeat One: Loop playback of the current file.

File Type The type of the playback file
® Video
® Image

® All: Videos and images

E Note

After the file type is selected, only the file of the selected type will be displayed
in the playlist.

Image Playback The duration of the image playback

Duration (s) The value ranges from 1 to 60 and it defaults to 5. (Unit: s)

Image Trans Effect The trans effect of the image

Supported trans effect: Ripple, zoom in, cut out, flip, blinds, H wipe, V wipe,
cube, dissolve, grid, swapping, scroll, fade in/out, twirl, heart trans, doorway,

perspective triangle, disappear, bounce, pinwheel and random

Image Trans Duration | The trans duration of the image

(s) The value ranges from 0.5 to 2 and it defaults to 0.5. (Unit: s)
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Parameter Description

Auto Playback Set whether to automatically play the USB files after the device is powered off

and then power on with a USB drive inserted.

e @:0n
If Resume Playback not enabled, replay the files in the playlist in order; If
enabled, replay the file being played before power failure from the
beginning.

o (I: Off

Resume Playback ® On: If afile is playing before the device power failure, enabling this function
allows to replay the file from beginning after the device is powered on with
a USB drive inserted.

® Off: Replay the files in the playlist in order.

E Note

® Enabling Resume Playback will also activate the Auto Playback feature at
the same time.

® After Resume Playback is enabled, if the file being played before power
failure cannot be found, the files will be played from the beginning of the

playlist in order.

Volume Playback volume of a media file

The value ranges from 0 to 100 and it defaults to 50%.

5.11 Advanced Settings

5.11.1 End-to-End Backup

The end-to-end backup is supported, including device backup, input source backup and

Ethernet port backup test, stable and reliable.

5.11.1.1 Device Backup

The backup between devices and Ethernet ports are both supported.

5.11.1.1.1 Backup Between Devices

Device backup allows you to set the backup relationship between two devices. You can set one

of the devices as the primary device or the backup device. When the primary device has a
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problem or the primary device's Ethernet cable fails, the backup device will take over the
responsibilities of the primary device seamlessly and continue to work well to ensure the LED

screen will not go black.

Prerequisites

Notes

Before creating a backup relation, make sure that both the primary and backup devices are

on the same LAN.

In a backup relation, the models and device versions of the primary and backup devices must

be the same.

You have three options to create a backup relation: NovaLCT, Unico, or the device LCD
menu. However, be aware that these methods do not synchronize with each other. Using
more than one can lead to data problems. To prevent issues, choose only one method for
setting up your backup. If you do mix them, you'll need to reset the device to factory settings

and start over with just one method.

In the device backup mode, the quantity of the cabinets loaded by each Ethernet port on
both the primary and backup devices must be the same, but their data flow must be in a

reversed way.

Hardware Connections

The diagram takes the VX2000 Pro as an example.
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LED Screen

=
Control PC

Screen Example

End-to-End Backup
Device Backup

Device Backup

Device Backup Primary
Input Backup
Ethernet Port Backup Test
Dual RV Cards Backup

Backup IP Primary
Backup

Operating Procedure

Step 1 On the main menu screen, go to Advanced Settings > End-to-End Backup > Device Backup to

enter the device backup screen.
The available devices on the same LAN will be automatically searched.
Step 2 Set the primary device.

Step 3 Rotate the knob to select Backup IP and press the knob to display the backup IP list. Select the

desired IP address of a device to be set as a backup one.

E Note

o After a backup relation is created, the configuration parameters (except communication

settings) of the primary device will be automatically synchronized to the backup device.
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e After a backup relation is created, you can adjust the screen parameters on the front panel of
the backup device without unbinding the backup relationship when the primary device is

powered off.

5.11.1.1.2 Backup Between Ethernet Ports

Ethernet port backup allows you to set the backup relationship between two Ethernet ports.
When the primary port has a problem or the primary port's Ethernet cable fails, the backup port
will take over the responsibilities of the primary port seamlessly and continue to work well to
ensure the LED screen will not go black. When setting the backup between the Ethernet ports,

you need to complete it in NovaLCT.

Hardware Connections

This diagram takes the VX2000 Pro as an example.
LED Screen

[ ] v e W20 hwizo oW 13 " %

Video Source

Operating Procedure

Step 1 Run the NovalCT software. On the menu bar, go to User > Advanced Synchronous System
User Login. Enter the password and click Login.

Step 2 Click Screen Configuration to enter the screen configuration page.

Step 3 Click Next to enter the screen configuration page.
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Figure 5-16 Screen configuration

Screen Configuration-COM$9 - a x
Sending Card  Receiving Card Screen Connection
Display Mode
 Refiesh

Current Display Mode

Sending Card 277 Graphics Output R. 1920 x 1080 Curre. 272
Select Input Source

Video Input 3D Function .
[ Automati + |send [ Enable [ settings

Source Confiquration

Source HOMI ~

Resolution 1920x1080px v [ Custom... 1920 5| x [1080

Refresh Rate T. 80 ~| Hz InputSource BitDe... |8Bi | s

[ ser
Hot Backup Verification
)
Redundancy —
Setthe Current Devi... [] Setas Primary [] Setas Backup ‘*
Primary Backup
i‘;ﬂ:;s‘ggﬁ;(n“gf Serial Number of %Zliw‘g’g:;(n:f Serial Number of
Card Primary Port Card Backup Port
| Reesn || send (adss| (Bt | Speietery
|

Step 4 Select the Sending Card tab, and then click Add in the Redundancy area.
Step 5 Set the serial numbers of both the primary device and backup device to 1.

Step 6 Set the serial number of the primary port and the serial number of the corresponding backup

port.

Figure 5-17 Ethernet port backup

1

4k

Serial Mumber of Primar.. |1 = Serial Number of Backu...

Serial Number of Primar... |4 - Serial Number of Backu... " =
e o

Step 7 Click Add to complete the backup settings of an Ethernet port, and the system will

automatically list the primary ports and backup ports.
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Step 8 Repeat Step 6 and Step 7 to complete the backup settings for other Ethernet ports.

Figure 5-18 Primary Ethernet ports

Screen Configuration-COM9% - [m] X

Sending Card  Receiving Card  Screen Connection

Display Mode

 Refresn |
Current Display Mode
Sending Card 272 Graphics Output R. 1920 x 1080 Curre. 222
Select Input Source
Video Input ) 3D Function ) .
[ Automati v ‘“ [ Enable Settings
Source Configuration
Source: HOMI v
Resolution 1920x1080px  ~ [J Custom.. 1920 5| x[1080
RefreshRate T gp ~| Hz Input Source BitDe... |8Bi v
\‘*
Hot Backup Verification -
\‘*
Redundancy e
Setthe Current Devi... [ ] Setas Primary [] Setas Backup ‘*
Primary Backup

Serial Number of
Backup Sending

Serial Number of

Serial Number of
Primary Sending erial Number o

Backup Port

Serial Number of

Card Primary Port Card

»

bttt st () () (s

[Restore Factor | Bwponsueen. sawsysemco. | sae | cise |

5.11.1.2 Input Backup

Notes

Input backup allows you to set the backup relationship between two input sources. When one

input source has a problem or the input connector fails, the backup source will be used

seamlessly and continue to work well to ensure the LED screen will not go black.

Input backup rules:

® |n each backup group, two input sources serve as the backup for each other.

® The backup relation can only be established if the input connectors have identical capacities.

® The USB source supports the input backup settings.

® FEach primary or backup source can have only one backup or primary source.

® Restrictions on input backup functions:

Input sources A and B form a hot backup group. The current input source of the layer is

input source A.

- Input A: No signal. Input B: Signal

www.novastar.tech

55



NOVASTAR VX Pro Series All-in-One Controller User Manual

The layer input source is switched to input B automatically. When input A resumes and
input B still has a signal and Primary Source Preferred is not enabled, the layer input
source will not be changed.

- Input A: No signal. Input B: Signal

The layer input source is switched to input B automatically. When input A resumes, but

input B does not have a signal, the layer input source will be changed to input A.
- Input A: No signal. Input B: No signal

The layer input source will not be changed.
- Input A: Signal. Input B: No signal

If you manually switch the layer input source to input B, the source will automatically
switch to input A.

Screen Example

End-to-End Backup Input Backup

Device Backup Input Backup
Input Backup
Ethernet Port Backup Test

Dual RV Cards Backup

Primary Source Preferred
Primary

HDMI 1

N/A

N/A

N/A

Operating Procedure

Step 1 On the main menu screen, go to Advanced Settings > End-to-End Backup > Input Backup to
enter the input backup settings screen.

Step 2 Rotate the knob to select Input Backup and press the knob to turn on the function.
Step 3 Rotate the knob to select the desired primary input source on the left side.

Step 4 Rotate the knob to select the desired backup input source on the right side.

Step 5 (Optional) Set the primary source preferred.

® On: The primary source will always be used if there is a signal. When the primary source fails,
the layer input source is switched to the backup one automatically. Once the primary source

resumes, the layer input source seamlessly switches back to the primary source.
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® Off: The layer input source will be switched to the primary source only when the backup one
fails and the primary one has a signal.

5.11.1.3 Ethernet Port Backup Test

Test whether the pre-stored images, backup Ethernet ports and devices take effect without
plugging and unplugging the Ethernet cables.

Prerequisites

The pre-stored images, primary and backup Ethernet ports or primary and backup devices have
been configured.

Screen Example

End-to-End Backup
Device Backup >
Input Backup >
Ethernet Port Backup Test Off
Dual RV Cards Backup |Off

Backup Only
Primary Only
Disconnect All

Parameter Descriptions

Parameter Description

Off Enable the output of all the Ethernet ports on the current device to
complete the test.

Backup Only Disable the output of the primary Ethernet port on the current device to test
whether the backup port or device takes effect.

Primary Only Disable the output of the backup Ethernet port on the current device to test

whether the output of the primary port is normal.

Disconnect All: Disable the output of all the Ethernet ports on the current device to test

whether the pre-stored image takes effect.
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5.11.1.4 Dual RV Cards Backup

Receiving card backup allows you to set the backup relationship between two receiving cards. If
the primary receiving card link fails, the backup one will take over the responsibilities of the

primary receiving card and continue to work well to ensure the LED screen will not go black.
Prerequisites
Two receiving cards are connected to the cabinet.

Notes

When you enable both the device backup and dual receiving cards backup, the former takes
precedence over the latter. When the layer sources of two devices are disconnected, the device

will switch to the backup receiving card link.

Screen Example

End-to-End Backup

Device Backup

Input Backup

Ethernet Port Backup Test
Dual RV Cards Backup

Parameter Descriptions

Parameter Description

Dual RV Cards Backup | Turn on or turn off the function.
e @:0On
o CID: Off
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5.11.2 Synchronization

This function allows you to select a synchronization signal to synchronize all the cascaded
device units or synchronize the primary and backup devices to display the output images of all
the units in sync.

Notes

® The input source with or without signal can be used as a sync source. When a no signal
source is used, the sync fails.

® Synchronizing to a DP source is supported by the VX2000 Pro only.

® Before enabling the Genlock sync function, make sure the sync signal has been connected to

the Genlock connector of the device.

Screen Example

Synchronization

Status Successful
SyncTo HDMI 1
Sync Frame Rate 60.00

Operating Procedure

Step 1 On the main menu screen, go to Advanced Settings > Synchronization to enter the

synchronization settings screen.

Step 2 Rotate the knob to select Sync To and press the knob to display the sync source list. The
options include Internal, an input source connected to the device's video connector and
Genlock. ("X" represents the input source number and its format may vary depending on the

actual setup.)

® |Internal: The frame rate of the output image

® Aninput source connected to the device's video connector: Sync with the frame rate of the

selected input source. After a sync source is selected, the sync frame rate will be displayed.
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® Genlock: Sync with the frame rate of the Genlock signal.
Step 3 (Optical) If Internal is selected, you can manually set the output frame that defaults to 60Hz.

Once the synchronization is successful, the screen will show Successful

5.11.3 Audio Settings

This function allows you to set the audio status, output audio, volume and input audio.

Hardware Connections

The diagram takes the VX2000 Pro as an example.
® Via a multifunction card

Connect the Ethernet port 1 or 2 to a multifunction card, and then connect the multifunction

card to an external speaker.

LED Screen

Multifunction

©
Card

Speakert i

® Via the audio output connector

Connect the audio output connector to an external speaker.
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LED Screen

Screen Example

Audio
Status
Output
Volume

Input Audio

5.11.3.1 Set Audio Status

Turn on or turn off the audio.

Screen Example

Audio
Status
Output
Volume
Input Audio
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Operating Procedure

Step 1 On the main menu screen, go to Advanced Settings > Audio to enter the audio settings screen.
Step 2 Rotate the knob to select Status and press the knob to confirm.

Step 3 Rotate the knob to select On or Mute to turn on or turn off the audio.

5.11.3.2 Select Output Audio

Set to output the layer audio, analog audio or embedded audio of an input source.

Screen Example

Audio
Status
Output

Volume
Input Audio

Operating Procedure

Step 1 On the main menu screen, go to Advanced Settings > Audio > Output and press the knob to

display the output audio list.
Step 2 Select the desired output audio and press the knob to confirm.

® | ayer n: Output the audio of the current layer input source. When you switch the current

layer input source, the audio will also be changed.

® Audio In: Output the analog audio coming from an external audio device. When you switch

the current layer input source, the audio will not be changed.

® Embedded audio of an input source: Output the fixed embedded audio. When you switch

the current layer input source, the audio will not be changed.

The supported input source types include HDMI sources, DP sources, and USB sources.
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E Note

The input source audio of the layer 1 is output by default.

5.11.3.3 Set Output Volume

Adjust the output volume.
Screen Example

Audio
Status

Qutput

Volume

Input Audio

Operating Procedure

Step 1 On the main menu screen, go to Advanced Settings > Audio to enter the audio settings screen

Step 2 Rotate the knob to select Volume and press the knob to confirm. Then rotate the knob again to
adjust the audio volume and press the knob to confirm.

Parameter Descriptions

Parameter Description

Volume The output volume

The value ranges from 0 (silent) to 100 (loudest) and defaults to 50.

5.11.3.4 Set Input Source Audio

Bind audio sources of different types to video sources. When you switch the layer source, the
audio source will be synchronously changed.
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Screen Example

Input Audio
HDMI 1
HDMI 2
HDMI 3
HDMI 4

HDMI 5
HDMI 6

DP

SDI

USB Source

Operating Procedure

Embedded

Embedded
Audio In

Embedded
Embedded
Embedded
Embedded

None
Embedded

Step 1 On the main menu screen, go to Advanced Settings > Audio > Input Audio and press the knob

to enter the corresponding screen.

Step 2 Select the desired input source and set the corresponding parameter.

Source Type Description
DP/HDMI/USB source Supported options: Embedded, Audio In
SDI source Supported options: None, Audio In

5.11.4 Low Latency

When the input source travels from where it comes to the processing device, sending device

and then the receiving card, latency exists inevitably. Turning on this function can effectively

help to reduce the latency from the input to output.

Notes

If you set the low latency mode to Auto, the system will determine whether to enable the low

latency based on the screen topology. The specific rules are as follows.

® For asingle Ethernet port with vertical cabling and no overlap in the Y direction, the low

latency will be automatically enabled if all the following requirements are met; otherwise, it

will be disabled.

- The cabinets loaded by one Ethernet port cannot be overlapped, while blank

configurations are allowed.
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- The circumscribed rectangles of all cabinets loaded by Ethernet ports must be aligned

at the top of the canvas.

- No need to keep the same cabinet size.

Portl| |Port 2 ,ﬁ ‘Ponn|
o S .

® For free topology, the low latency will be automatically enabled if all the following
requirements are met; otherwise, it will be disabled.

- The cabinets loaded by one Ethernet port cannot be overlapped, while blank

configurations are not allowed.

- The circumscribed rectangles of all cabinets loaded by Ethernet ports must be aligned
at the top of the canvas. The size of the circumscribed rectangle cannot exceed 650,000

pixels.

- The size of all cabinets must be the same.

Operating Procedure

On the main menu screen, go to Advanced Settings > Low Latency and press the knob to

confirm. Then, rotate the knob to select On, Off or Auto as needed.
e Off: Turn off the function. (Default option)

® On: Turn on the function. The device latency can be reduced by 1 frame.

E Note

After you manually enable the low latency function, it is advisable to align the circumscribed
rectangle loaded by each Ethernet port at the top of the canvas. If not aligned, the loading
capacity will be reduced. For calculating the actual loading capacity, please refer to Loading
Capacity Calculation Method in Low Latency Mode.

® Auto: If you set the low latency mode to Auto, the system will determine whether to enable
the low latency based on the screen topology. If the wiring meets the rules, low latency will
be enabled automatically; otherwise, it will be disabled automatically. For specific rules,
please refer to the notes in this section.
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5.11.5 HDR

HDR is the abbreviation for High-Dynamic Range. HDR function can greatly enhance the display
image quality, allowing for a more clear and vivid image when the device is used together with

the specified receiving cards.

E Note

Only the VX2000 Pro supports the HDR function.

5.11.5.1 HDR Source Settings

Set the related parameters of an HDR source.

Prerequisites

® Use the layer 1 source as an HDR source.

® An HDR source (HDR10/HLG standard) must be used to realize optimal HDR effect.

Notes

® An HDR source can be connected to the HDMI 2.0 or 12G-SDI connector only.
® The HDR and 3D functions cannot be used together.

® Using the HDR function paired with receiving cards of different models will reduce the
device loading capacity by half or quarter because the HDR input source is 10-bit. Please

work out a connection solution in advance.

Screen Example

HDR Settings HDR Source Settings
HDR Source Settings HDR Source

EOTF Adjustment Dynamic Range
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Operating Procedure

Step 1

Step 2
Step 3

Step 4

On the main menu screen, go to Advanced Settings > HDR Settings > HDR Source Settings to

enter the HDR source settings screen.

Rotate the knob to select HDR Source and press the knob to expand the HDR source list.
Rotate the knob to select the target HDR source and press the knob to confirm.

Set the dynamic range of the HDR source.

Figure 5-19 HDR effect

Original HDR

Parameter Descriptions

Menu Description

HDR Source You can select an HDR source connector through the HDMI 2.0 or 12G-SDI
connector.

Dynamic range The dynamic range of an HDR source
The supported options include HDR10, HLG, off and From Input.

E Note

When you enable the HDR function, the receiving card supporting this function should be used
together. For the specified receiving card model and related information, please refer to our

official website (www.novastar.tech).

5.11.5.2 Adjust EOTF

EOTF is the abbreviation for Electro-Optical Transfer Function. It allows for precise tuning of
the electro-optical conversion characteristics of a signal source, significantly improving the

overall brightness performance, details of the darkest areas, clarity of the highlight areas and
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final contrast effect. Additionally, adjusting images based on different ambient light conditions

is also supported to achieve a more desirable viewing experience.

Notes

The supported adjustment parameters depend on the HDR source settings.

Screen Example

HDR Settings
HDR Source Settings
EQTF Adjustment

Parameter Descriptions

EOTF Adjustment
Shadow Compensation 33%

Ambient Light Compensation 0%
Clip Level 0%
Override Peak Screen Brightness @@
Peak Screen Brightness 1000nits

Reset

Parameter

Description

Shadow Compensation

Adjust this parameter to enhance the image display effect. The greater the

value, the clearer the details in the shadow area.

Range: 0 to 100 (default: 33), Step: 1

Ambient Light

Compensation

Adjust this parameter to reduce the loss of image details caused by ambient
light diffusion.

Range: 0 (default) to 80, Step: 1

Clip Level

Adjust the parameter to reduce the screen overexposure and enhance
details of the highlight areas.

Range: 0 (default) to 100, Step: 1

Override Peak Screen
Brightness

Turn on or turn off the function.
e On: @
e Off: (D

Peak Screen Brightness

Adjust the brightness of the screen when it is functioning normally.

When Override Peak Screen Brightness is enabled, this parameter can be
adjusted. Range: 100 to 10000 nits (default: 1000 nits), Step: 1
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5.11.6 3D Settings

Directly connect a third-party 3D emitter using the device's built-in 3D connector, or connect to
the EMT200 Pro emitter via the device's Ethernet port. Then, use the compatible 3D glasses to
achieve a 3D display effect.

Prerequisites

® Video source format: Side-by side, top-and-bottom or frame sequential

® When paired with the EMT200 Pro, it is recommended to use a 3D source of 60Hz to enjoy

an optimal experience.

Notes

® When the 3D function is enabled and the video source format is Side-by-Side or Top-and-

Bottom, the device output capacity will be halved.

® When the 3D function is enabled and the video source format is Frame Sequential, you need

to manually set the output frame rate which must be the same as the input frame rate.

® The 3D effect follows the layer. The output area where a 3D layer is located always displays
the 3D effect.

® The 3D function and input cropping cannot be enabled at the same time.

Hardware Connections

The diagram takes the VX2000 Pro as an example.

Screen

EMT200 Pro

Input Signal
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Screen Example

3D Settings
Status ]
Source Format Side-by-Side
Eye Priority Left
Enable Third-Party Emitter ®

Signal Delay (us)

Turning on 3D mode will halve the device cutput capacity)
Pay attention to the cabinet connection.

Operating Procedure

Step 1 On the main menu screen, go to Advanced Settings > 3D Settings > Status to turn on the

function.

Step 2 Select the 3D format of the video source. The options include Side-by-Side, Top-and-Bottom

and Frame Sequential.
Step 3 Set the eye priority. The options include Left and Right.
Step 4 (Optional) Turn on the Enable Third-Party Emitter switch.
Step 5 Set the signal delay duration.

The value ranges from 0 to 20000 and defaults to 7000. (Step: 1, unit: us)

5.11.7 Standby Mode

Enabling standby mode can effectively reduce energy consumption caused by screen heat

generation.

Parameter Descriptions

Parameter Description
Standby Mode Turn on or turn off this function.
e @:0On

Once the standby mode is enabled, the output image will go black and
the output volume will be adjusted to 0. The device LCD screen will also

be locked, while other parameters remain unchanged.
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Parameter Description

o (I: Off

5.11.8 HDCP Status

High-bandwidth Digital Content Protection (HDCP) is a form of digital copy protection to
prevent copying of digital audio and video content as it travels across connections. When the
accessed input source is an HDCP-encrypted one, you need to turn on this function to enable

the device to transmit and process the source.

Parameter Descriptions

Parameter Description

HDCP Status Turn on or off HDCP function for the input source.

5.11.9 Monitor Settings

Real-time display of the output image via the monitor connected is supported. You can monitor
whether the output is normal and adjust the display ratio of the monitoring image on the

monitor to avoid image distortion.

Parameter Descriptions

Parameter Description

Scaling Mode The options include Keep Ratio and Full Screen (default).
® Keep Ratio: Keep the ratio of the original output image to display.

® Full Screen: Display the output image in full screen.

E Note

When Keep Ratio is selected, the blank area that the output image cannot

cover the entire monitor screen will be automatically filled with solid black.

Definition The supported options include Smooth and High-Definition.
® Smooth: The monitoring image definition is 1920x1080@60Hz.
® High-Definition: The monitoring image definition is 3840%2160@60Hz.
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5.12 System Settings
5121 Fn

This function allows you to set a shortcut button for an assigned function. By using the Fn

button, you can quickly navigate to the target menu screen and never need to access a
specified menu item by entering the menus level by level.

Screen Example

Fn
Synchronization
FTB

Ethernet Port Backup Test
Audio

Operating Procedure

Step 1 On the main menu screen, go to System Settings > Fn press the knob to enter the Fn button
settings screen.

Step 2 Rotate the knob to select the desired function and press the knob to confirm.

5.12.2 Return to Home
Operating Procedure
Step 1 On the main menu screen, go to System Settings > Return to Home and press the knob to

confirm.

Step 2 Rotate the knob to select the desired time value and press the knob to confirm.
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Parameter Descriptions

Parameter Description

Return to Home You can set the period when the system stays at the current screen before
returning to the homepage automatically when there is no operation

performed.

The value ranges from 60s to 3600s

5.12.3 Diagnostics

Notes

The diagnostics function helps you to diagnose the system and troubleshoot the malfunctioned
device components. When the device fails, you can run the diagnostics function to test the
device. You can send your test to our technical support staff for problem locating and
processing. For daily maintenance, you can run the diagnostics function to do the routine health

check for the system.

Running diagnostics will transiently disrupt the output, and the output will resume after the

diagnostics are completed.

Operating Procedure

Step 1

Step 2

Step 3

On the main menu screen, go to System Settings > Diagnostics and press the knob to enter

the diagnostics screen.
Rotate the knob to select Run Diagnostics and press the knob to confirm,

In the popup dialog, rotate the knob and select Yes and press the knob to confirm.

5.12.4 Export Logs

Export the device logs to a USB drive to quickly identify issues.

Prerequisites

Before exporting logs, you have inserted a USB drive into the USB port on the device.

www.novastar.tech 73



NOVASTAR VX Pro Series All-in-One Controller User Manual

Operating Procedure

Step 1 On the main menu screen, go to System Settings > Log Export to enter the log exporting

screen.

Step 2 Rotate the knob to select Apply and press the knob to confirm. The log file will be exported to

the root directory of the USB drive.

5.12.5 Update Device

Import the update file saved in a USB drive to the device for quick update.

Prerequisites

Notes

Before updating the device, you need to decompress the firmware package and copy the
update file (.img) to the root directory of a USB drive. The supported USB drive formats
include NTFS, FAT32, and exFAT. It is recommended to use a USB drive in FAT32 format.

Before updating the device, you need to insert a USB drive with the update file into the USB

2.0 port on the device rear panel.

During the update process, power-off and all operations are NOT allowed.

Additionally, you can update the device via Unico or NovaLCT. For detailed operations,

please refer to Maintain Devices or NovaLCT user manual respectively.

Screen Example

System Settings Update

Fn VX2000_ProV1.2.0.img
Return to Home

Diagnostics

Log Export

Update

Restore Device

Cascading ID

Remote Control
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Operating Procedure

Step 1 On the main menu screen, go to System Settings > Update to enter the device update screen.

Step 2 Rotate the knob to select the update file and press the knob to confirm.

Step 3 In the popup dialog box, rotate the knob to select OK and press the knob to confirm. Then wait
for the device to automatically complete the update.

5.12.6 Restore Devices

Each restore point is a snapshot of the device configuration at a specific moment. If something
unexpected occurs, simply select a restore point to quickly revert the device configuration to
the state it was in at the time the restore point was created.

Prerequisites
None
Notes

Up to 5 restore points can be created (total capacity limit: 1GB).

Screen Example

Restore Device
20260114_165725

New Restore Point

Operating Procedure

Step 1 On the main menu screen, go to System Settings > Restore Device to enter the device
restoration screen.
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Step 2 Perform the following operations as needed.

® Add the restore point: Rotate the knob to select New Restore Point and press the knob to

confirm.

The prefix for the name of the new restore point is the date when the operation is

performed.

® Restore the device: Rotate the knob to select the target restore point and press the knob to

confirm. In the popup dialog box, select Restore and press the knob to confirm.

® Delete the restore point: Rotate the knob to select the target restore point and press the

knob to confirm. In the popup dialog box, select Delete and press the knob to confirm.

5.12.7 Cascading ID

Set the device cascading ID which is the unique identification when the device is in a cascading
link.

Notes

® The cascading ID defaults to 1 and can be changed manually. You need to set an ID for each

cascading device in order.

® After you set IDs successfully, connect devices using Ethernet cables based on the set ID.

Parameters Description

Parameter Description

Cascading ID When multiple devices are cascaded, you need to set a virtual ID for each

device, ensuring that the devices displayed in NovaLCT match with actual

devices.

5.12.8 Remote Control

Enable or disable the remote control.

Prerequisites

® |Insert the matching Bluetooth module into the USB 2.0 port on the device rear panel.
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® The remote control and the device have been successfully paired. For the pairing method,

please refer to Button Descriptions

® The resolution of the loaded LED screen must be greater than 800x600.

Notes

® The remote control is an optional accessory and must be purchased separately.

® Effective operating distance of remote control: within 10 meters from the device

Screen Example

System Settings
Fn

Return to Home
Diagnostics
Log Export
Update

Restore Device

Cascading ID

Remote Control

Parameter Descriptions

Parameter

Description

Remote Control

Turn on or turn off the function.
e On: @
o Off: (OB

5.13 Factory Reset

Factory reset function allows you to reset all the parameter settings of the device to factory

defaults after the device update or when you think the parameters are improperly set.
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Screen Example

Factory Reset

Save IP

i Resetall except cabinet configuration filesand
communica ngs

Keep User Data

i Input EDID, communication, Fn, imported
name and rest points

Reset All

Parameter Descriptions

Parameter Description

Save IP Reset the parameter settings to factory defaults, except for the

configuration file and communication parameter settings.

restore points.

Keep User Data Reset the parameter settings to factory defaults, except for the input EDID,

communication parameter settings, Fn, imported files and device name and

Reset All Reset all the parameter settings to factory defaults.

5.14 Communication Settings

You can set the communication and network information to enable the device to communicate

with the control PC smoothly.

Screen Example

Communication

Network Mode Manual
IP Address 192.168.0.10

Subnet Mask 255.255.255.0
Gateway 192.168.0.1

MAC de:90:1d:d9:11:29

Reset)  Apply
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Operating Procedure

Step 1

Step 2

Step 3

Step 4

On the main menu screen, rotate the knob to select Communication and press the knob to

enter the communication settings screen.

Select Network Mode and press the knob to confirm.

The options include Manual and Automatic.

® Manual: Set the device IP address, subnet mask and gateway manually.

® Automatic: The system automatically assigns an IP address for the device. When the device

and control PC are connected to the same router or switch, set this option to Automatic.

When the Manual option is selected, you must manually set the device IP address, subnet mask

and gateway.

Rotate the knob to select Apply to make the settings take effect; otherwise, select Reset to

reset the settings to defaults.

E Note

Rotate the knob to Reset and press the knob to confirm, and then all network parameters will be

reset to defaults.

5.15 Device Working Mode

Three working modes are supported, including Video Controller, Fiber Converter and ByPass.

Screen Example

Device Mode
Fiber Converter

Video Controller

ByPass
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Parameter Descriptions

Table 5-4 Fiber converter

Device Model

Description

VX400 Pro

Optical fiber ports are used for input, and Ethernet ports are used for
output.

® OPT 1~2 are used for input, and Ethernet ports are used for output.

® OPT 1 serves as the primary connectors. The Ethernet ports 1~4 transmit
OPT 1 data.

® OPT 2 serves as the backup connectors.

VX600 Pro

Optical fiber ports are used for input, and Ethernet ports are used for
output.

® OPT 1~2 are used for input, and Ethernet ports are used for output.

® OPT 1 serves as the primary connectors. The Ethernet ports 1~6 transmit
OPT 1 data.

® OPT 2 serves as the backup connectors.

VX1000 Pro

Optical fiber ports are used for input, and Ethernet ports are used for

output.
® OPT 1~2 are used for input, and Ethernet ports are used for output.

® OPT 1 serves as the primary connectors. The Ethernet ports 1~10 transmit
OPT 1 data.

® OPT 2 serves as the backup connectors.

VX2000 Pro

Optical fiber ports are used for input, and Ethernet ports are used for

output.
® OPT 1~4 are used for input, and Ethernet ports are used for output.

® OPT 1 and OPT 2 serve as the primary connectors. The Ethernet ports
1~10 transmit OPT 1 data, and Ethernet ports 11~20 transmit OPT 2 data.

® OPT 3 and OPT 4 serve as the backup connectors.

Table 5-5 Video controller

Device Model

Description

VX400 Pro ® OPT 1 can be used as an input or output connector depending on the
connected devices.
® OPT 1 sends the output on Ethernet ports 1~4. OPT 2 copies or backs up
the output on Ethernet ports 1~4.
VX600 Pro ® OPT 1 can be used as an input or output connector depending on the

connected devices.
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Device Model Description

® OPT 1 sends the output on Ethernet ports 1~6. OPT 2 copies or backs up
the output on Ethernet ports 1~6.

VX1000 Pro ® OPT 1 can be used as an input or output connector depending on the
connected devices.

® OPT 1 sends the output on Ethernet ports 1~10. OPT 2 copies or backs up
the output on Ethernet ports 1~10.

VX2000 Pro ® OPT 1 and OPT 2 can be used as an input or output connector depending
on the connected devices.

® OPT 1 and OPT 2 send the output on Ethernet ports 1~10 and 11~20
respectively. OPT 3 and OPT 4 copy or back up the output on Ethernet
ports 1~10 and 11~20 respectively.

Table 5-6 ByPass

Device Model

Description

VX400 Pro/VX600 Pro/VX1000
Pro/VX2000 Pro

Under this mode, the device works as an independent controller

with no support for video processing functions.

5.16 OPT Mode

Supports settings of both the OPT working mode and loop mode.

Screen Example

OPT Mode
OPT 3/4

OPT Loop

Hardware Connections

The diagram takes the VX2000 Pro as an example.
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Figure 5-20 Copy mode

LED Screen LED Screen

Ethernet Cable Ethernet Cable

Video Controller
HDMI Cable Optical Fiber Cable
L1
HDMI Source

Figure 5-21 Backup between Ethernet and OPT ports

Video Controller LED Screen

Ethernet Cable

1

HDMI
Source

Optical Fiber Cable

Ethernet Cable

Fiber Converter

=) Data flow of primary Ethemnet ports
=P  Data flow of backup Ethernet ports
Note:

If the Ethemet port of the device in video controller
mode fails, the LED screen can still work normally.
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Figure 5-22 OPT loop mode

LED Screen

Video Controller Ethernet
-

Cable

]

HDMI Source

HDMI Cable

D: Optical Fiber Cable

PIXELHUE Switcher
Optical Fiber Cable

LED Screen

Ethernet
Cable

Video Controller

Parameter Descriptions

Table 5-7 OPT working mode

Device Model Parameter Description

VX400 Pro OPT 2 ® Copy: OPT 2 copies the output on Ethernet ports 1~4.

® Backup: OPT 2 backs up the output on Ethernet ports 1~4.

VX600 Pro ® Copy: OPT 2 copies the output on Ethernet ports 1~6.
® Backup: OPT 2 backs up the output on Ethernet ports 1~6.

VX1000 Pro ® Copy: OPT 2 copies the output on Ethernet ports 1~10.
® Backup: OPT 2 backs up the output on Ethernet ports
1~10.
VX2000 Pro OPT 3/4 ® Copy: OPT 3 copies the output on Ethernet ports 1~10,

and OPT 4 copies the output on Ethernet ports 11~20.

® Backup: OPT 3 backs up the output on Ethernet ports
1~10, and OPT 4 backs up the output on Ethernet ports

11~20.
Table 5-8 OPT loop mode
Device Model Parameter Description
VX400 Pro/VX600 OPT Loop Loop out the video signal accessed by OPT 1 via OPT
Pro/VX1000 Pro/VX2000 2 for device mosaic.
Pro e @D Enable the loop mode.
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Device Model Parameter Description

o : Disable the loop mode.

5.17 About Us

Under this menu item, you can view the firmware version, device SN, official website and email
address. On our official website, you can check the latest device information and the updates

for this device. You can also send your feedback or suggestion to us for improvements via the

supplied email address.

Screen Example

About Us

Firmware Version;: V1.0.0

SN:202411131839456

Website: www.novastar.tech

Email: support@novastartech

5.18 Language

The language options include English, Simplified Chinese, Traditional Chinese, Hindi, Spanish,
French, Portuguese, Russian, Japanese, Korean, German, Vietnamese, Turkish, Thai and

Indonesian. You can switch to your preferred language.
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6 Remote Control

Enable or disable the device standby mode, power on or power off the screen, adjust the screen
brightness and output volume, switch presets, set the USB playback parameters, adjust the
output image quality, switch layer input sources and set the 3D function through a remote

control.

6.1 Button Descriptions

Figure 6-1 Remote control

2
3 5
4

6
7 9
8

10

11

Table 6-1 Button descriptions

No. Description

1 ® Enable or disable the standby mode.

® Connect a multifunction card and press this button to power on or power

off the screen.

2,6 Press the button to adjust the brightness by step, and hold down the button
for quick adjustment. Range: 0% to 100%, Step: 1

On the menu interface, the button can be used as the up/down button.
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No. Description
3,5 Play the previous or next USB media file.
On the menu interface, the button can be used as the left/right button.
4 Press the button to play the current USB media file or stop the playback.
7 Press the button to enter the Settings interface.
8 Return or exit button.
9 Press the button to enter the preset switching menu.
10 Press the button to increase the output volume.
11 Press the button to decrease the output volume.

E Note

Insert the matching Bluetooth module into the USB 2.0 port on the device rear panel, and then
simultaneously hold down the "6" and "8" buttons until the remote control's red light illuminates,

so that the remote control is successfully paired with the device.

6.2 OSD Menu Descriptions

Figure 6-2 All settings

© Setting
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Switch Presets

Figure 6-3 Interface example

B Switch Preset

Preset 01 Preset 02 Preset 03
v

Preset 04 Preset 05 Preset 06

Preset 07 Preset 08 Preset 09

Preset 10 Preset 11 Preset 12

Preset 13 Preset 14 Preset 15

Press the direction button to select the desired preset. After selection, press the OK button to

load the selected preset.

Switch Layer Input Sources

Figure 6-4 Interface example

8 Switch Source
Layer 2 Layer 3 Layer 4 Layer 5 Layer 6 Layer 7
© DP

® HDMI2 @ HDMI3

v

. ® HDMI4 ® HDMI5 ® HDMI6

® HDMI7 ® U-Disk

Press the direction button to select the desired layer and input source respectively. After

selection, press the OK button to switch the input source of the selected layer.

USB Playback

Figure 6-5 Interface example

& USB Playback

USB Player >

Playback Settings >

Sort >
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Table 6-2 Menu descriptions

Menu

Description

USB Player

Display the video and image file list.

Press the up/down button to select the desired file, and then press the OK
button to play the selected file.

Playback Settings

The supported parameters include Playback Mode, File Type, Image
Playback Duration (s), Image Transition Effect, Image Trans Duration (s),

Auto Playback and Resume Playback.

For detailed information, please refer to Playback Settings.

Sort

Select the desired media file, and then press the left/right button to adjust
the sequence of the selected file displayed in the playback list.

Adjust Image Quality

Figure 6-6 Screen example

@ Image Quality

Mode
Brightness
Contrast
Saturation

u

O Standard ©

70%

70%

o (o (o

70%

70!

e
o
0)
x

Table 6-3 Menu descriptions

Menu

Description

Eye Comfort Mode

Turn on or turn off this function.
e On: @
* Off:

Mode

The display mode of the output image

You can set the desired output mode based on the display content. The
supported options include Standard (default), Document, Conference and
Video.

E Note

When the eye comfort mode is disabled, you can customize and reset the

parameters of each mode.
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Menu Description

Brightness Brightness is the shading of lights in the image.

Contrast Contrast is the ratio of the luminance of the brightest color to that of the
darkest color.

Saturation Saturation is the colorfulness of the image. The higher the contrast, the
more vivid the image.

Hue The relative degree of how bright or dark the image is

Color Temperature Adjust the cool or warm degree of images displayed on the LED screen.

Adjust Brightness

Figure 6-7 Screen example

4 Brightness

@ — 70%

@ To ensure the brightness settings are retained the next time the screen is
powered on, please be sure to save them.

Press the left/right button to increase or decrease the screen brightness. After adjustments,

press the direction button to select Save and press the OK button to automatically save the

brightness parameter.

3D Settings

Figure 6-8 Screen example

9 3D Settings

Status

!

Source Format
Eye Priority
Third-Party Emitter

Signal Delay (us)

©® Side-by-Side ©
O Left ©®

@ )
® 700 ©

@ Note: Turning on 3D mode will halve the device output capacity.
Pay attention to the cabinet connection.
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Table 6-4 Menu descriptions

Menu

Description

Status

Turn on or turn off the switch.
e On: &
* Off:

Source Format

The format of the 3D video source

Set the format to Side-by-Side, Top-and-Bottom or Frame Sequential

according to the format of the accessed video source.

B Note

When the 3D function is enabled and the video source format is Side-by-Side

or Top-and-Bottom, the device output capacity will be halved.

Eye Priority

Set which image is sent first, the right eye image or the left eye image.

Put on the 3D glasses to view the screen. If the display appears abnormal,
adjust the parameter value to the other one. If the display is normal, no

further adjustments are needed.

Third-Party Emitter

Turn on or turn off the function.
e On: @
* Off:

Emitter Delay

Set the delay time of sending the synchronization signal from the 3D signal
emitter to the 3D glasses. This setting ensures that the switching between
left and right eye images of the 3D glasses is in sync with the switching
between the left and right eye images on the screen. This parameter is

applicable to both the NovaStar and third-party emitters.

Adjust Volume

Figure 6-9 Screen example

4 Volume

I

Press the left/right button to increase or decrease the volume.
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7 Software Control

You can control the all-in-one video controller via both the Unico client software and webpage.
Except for functions mentioned below, the other functions of the two operating terminals are

the same. Here we take the operations on the client side as an example to illustrate.

Function Module Unico Client Unico Webpage

Cabinet library Local pack, device pack Device pack

7.1 Software Installation and Connection

7.1.1 Software Installation

Prerequisites

® The software package is obtained.
® A computer meeting the following requirements is prepared:
Windows:
- Operating system: Windows 10 (64-bit) or later
- CPU: 9th Generation Intel i7 processor or above
- Memory: 16 GB or above

Mac OS: Mac OS 10.14 or above

Installation Method

Run the .exe file and follow the setup wizard to complete the installation. If a firewall prompt

appears, choose to allow the installation.
Installation Result

After a successful installation, the Unico software icon . is displayed on the desktop. Double-

click this icon to open the Unico software.
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7.1.2 Software Connection

The Unico software is installed on the control computer. The control computer can connect to
the device in the following two ways:

® \/ia Ethernet cable

Connect the device and the control PC directly via Ethernet cable and set a static IP address

for the device to let it and the control PC be on the same network segment.
® Via LAN

Connect the device and the control PC to the same LAN to ensure that both of them are on

the same network segment.

7.2 Project Management

Create, edit and dissolve projects. Project files (.uprj) can be exported from the current device

and imported into others, promptly applying device parameters and resource files.

7.2.1 Create New Projects

Devices of the same series on a local network are automatically added to a default project.
Users can create additional projects and move online devices from the default project to new
ones. Furthermore, simulation projects can be created to simulate real device configurations

and understand the product better.

Step 1 Open the software and access the main interface.
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Figure 7-1 Project

v Project2

No devices in the project

Step 2 Create an online project or simulation project.

® Online Project: Create a project for online devices. Select the Online Project tab at the top
left and click New Project at the top right. Enter the project name in the popup window and
click OK.

Figure 7-2 New projects

New Project

® Simulation Project: Create a project for simulation devices. Select the Simulation Project tab
at the top left and click New Project at the top right. Enter the project name in the popup
window and click OK.

After a simulation project is successfully created, please refer to Simulation Devices to add a

simulation device.

For online projects, devices of the same series are automatically grouped under one project.
When adding simulation devices, only devices of the same series can be included in a single

project.

E Note

In the project list area, you can perform the project-related operations.

www.novastar.tech 93



NOVASTAR VX Pro Series All-in-One Controller User Manual

o Edit project: Click Edit to rename the project.

e Export project: Click Export to export the online project file. Simulation projects do not support
exporting.

e Dissolve project: Click Dissolve to dissolve the current project. All online devices in the project
will be moved to the default project.

e Enter project: Click Enter to enter the device configuration page.

Step 3 Move devices between projects.

Expand the project list, hover over the target device, and click Move or manually drag it to

another project.
® Move: Choose the target project in the popup window, then click OK.
Figure 7-3 Move devices

Move Device

Search for

M Project 1
Device Qty - 0

® Manual drag: Manually drag to another project and click Yes in the popup window.

E Note

Devices of the same series can only be added into one project.

7.2.2 Import Projects

Step 1

Import the local project files (.uprj) to the device. Please note that the device models must

match with the models in the project file.

Select the Online Projects or Simulation Projects tab, and click Enter to access the device

configuration interface.
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Step 2 Navigate to File > Import from the menu bar.

Step 3 In the dialog box that appears, select a project file (.uprj) and click OK.

E Note

Simulation project files can be imported into online projects.

Step 4 In the displayed Import Project File window, select Online Projects or Simulation Projects.

Figure 7-4 Import project files

Import Project File

Online Projecis Simulation Projects
Matching List

Device in File Online Device Matching Result Parameters

Device 1 [ | Resource Files

192.168.50.10 [] Device Parameters

Step 5 After successful device matching, select the data to be imported and click OK.

The software matches the SN, name, IP address, model, and firmware version from the file with

the online or simulation device. Click to modify the match:
® For online devices, select other online devices from the drop-down menu.

® For simulation devices, choose to create a new simulation device. Ignore the current device,

or select another simulation device from the drop down menu.

7.2.3 Export Projects

Export the device project files to your local computer.

Step 1 Select the Online Projects or Simulation Projects tab, and click Enter to access the device

configuration interface.
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Step 2 In the menu bar, navigate to File > Export
Step 3 In the displayed dialog box, select the desired data.

Figure 7-5 Export project files

Export Project File

No etc., and do not include restore
points.
' Device 1
Device Parameters

Resource Files

Step 4 Click Export.

Step 5 In the displayed dialog box, select a file path and click Save.

E Note

On the Online Projects interface, you can also click Export on the right side of the project list to

export the project file.

7.3 Device Management

7.3.1 Enter Device Configuration Page

7.3.1.1 Online Devices

Step 1 Select the Online Projects tab.
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Step 2

Figure 7-6 Online project list (VX2000 Pro)

Double click the device front panel image or click Enter on the right side of the project list to

access the device configuration interface.

7.3.1.2 Simulation Devices

Step 1

Step 2

Step 3

Simulation devices, without any physical connections, simulate real device configurations,

enabling users to easily utilize and understand the software.
Select the Simulation Projects tab.

Click Add simulation devices.

E Note

The device models supporting the simulation device function include the VX400 Pro and VX2000

Pro.

In the pop-up dialog box, set the device name, model, and IP address, and click OK.
Once created, the device will be displayed in the list and will be in the default started state.
o .: The device is started.

° E: The device is off.
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Figure 7-7 New simulation devices (VX2000 Pro)

New Simulafion Devices

Name Device2

Device Model = VX2000 Pro

IP Address 192

Card Slots

OUTPUT

00 00 00 00 00 00 00 00 00 00

CONTROL

E Note

For devices in the project list, you can perform the following operations:

e Start all devices: Click Start All.

e Shut down all devices: Click Shut Down All.

e Shut down device: Click Shut Down.

e Start device: Click Start.

e Edit device: Click Edit.

e Move device: For an active device, click Move, choose the target project in the popup window,
and click OK.

e Delete device: Click Delete.

Step 4 After creation, you can view the device status, name, IP address, and model.

® Double click the device front panel image or click Enter on the right side of the project list to

access the device configuration interface.

® Hover over the device information to start, shut down, edit (modify device name, IP address),

move, or delete the device.

-+ Add simulation devices
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7.3.2 Configure Device Properties

Select the device on the left side of the device configuration interface, and then configure the

device-related properties on the right pane.

Figure 7-8 Device properties (VX2000 Pro)

1921685010 | VX2000 Pro.

VX2000 Pro

gUDDD | e e e o e o o e e o e o o
imocoOfle 090 © ©

E Note

Click Collapse to collapse the device list.

7.3.2.1 Rename Device

Change the device name.

Prerequisites

None

Notes

None
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Interface Example

Device Name Device 1
Firmware V130
Device SN virtual1767662 129894

MAC Address EOBE03:74:9CES

Working Mode Video Coniroller

Description

Enter a name for the device in the text box next to Device Name.

7.3.2.2 Switch Working Mode

Switch the device working mode.

Prerequisites
None
Notes
Set the device working mode according to the on-site application and screen connections.

Interface Example

Working Mode Video Controller

Description

Select Video Controller, Fiber Converter or ByPass from the drop-down list.

7.3.2.3 Configure IP Address

Manually set a static IP address for the device or let the device to automatically obtain an IP

address.
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Prerequisites

None

Notes

Devices on different network segments are not automatically discovered. If you change the

device IP to another network segment, the device could not be discovered.

Interface Example

 Network Settings

Neiwork Mode

IP Address

Subnet Mask

Gateway

Description

Configure the following parameters and click Apply to make the settings take effect.

Parameter Description

Network Mode Select the IP configuration method.
® Manual: Manually set a static IP address for the device.

® DHCP: The device automatically obtains an IP address.

IP Address The device IP address
Subnet Mask The subnet mask of the IP address
Gateway The default gateway

7.3.2.4 Configure Sync Source

Select a sync signal to synchronize all the cascaded device units or synchronize the primary and

backup devices to display the output images of all the units in sync.

www.novastar.tech 101



NOVASTAR VX Pro Series All-in-One Controller User Manual

Prerequisites

None

Note

None

Interface Example

v Sync

Screen1

Sync To Intemnal Frame Rate

Frame Rate 60 Hz

Description

Parameter Description

Sync To Select a sync source.
® Internal Frame Rate: The frame rate of the output image

® Input source connected to the device video connector: Sync with the frame rate

of the selected input source.

"X" represents the input source number and its format may vary depending on

the actual setup.

® Genlock: Sync with the frame rate of the Genlock signal.

When the function is enabled, the frame rate of the sync source will be displayed.

Frame Rate When you select Internal Frame Rate, you can manually set the output frame

rate. The default value is 60Hz.

7.3.2.5 Configure HDCP

High-bandwidth Digital Content Protection (HDCP) is a form of digital copy protection to
prevent copying of digital audio and video content as it travels across connections. When the
accessed input source is an HDCP-encrypted one, you need to turn on this function to enable

the device to transmit and process the source.
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Prerequisites

None

Notes

None

Interface Example

Description
Parameter Description
HDCP Turn on or turn off the function.

° (): On
o OB Off

7.3.2.6 Configure Date and Time

Configure the time zone, date and time of the device.

Prerequisites

None

Notes

None
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Interface Example

v Time

Time Zone (UTC+08:00) Asia/Shanghai

Date 2026-01-22

Time 09:36:09

Edit

Description

Click Edit and the parameters become editable. Set the time zone, date and time respectively,

and then click Apply.

7.3.2.7 Reset to Factory Settings

Reset the device data and settings to factory default values.
Prerequisites
None

Notes

Please do this with great caution.

The reset action does not affect the device firmware version.

Power-off is not allowed during the reset process.

The device will restart automatically after the reset is completed.

Interface Example

v Factory Reset

Retain user data @
Retain IP only

Reset all
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Description

Select Retain user data, Retain IP only or Reset all, and then click Apply.
® Retain user data

Retain the input EDID, imported files, language, device name, device IP, belonged project
and restore points.

® Retain IP only
Only retain the device IP address and reset other parameters to factory defaults.
® Reset all

Reset all parameters.

7.3.2.8 Standby Mode

Enabling standby mode can effectively reduce energy consumption caused by screen heat

generation.
Prerequisites

None
Notes

Once the standby mode is enabled, the output image will go black and the output volume will
be adjusted to 0. The device LCD screen will also be locked, while other parameters remain

unchanged.

Interface Example

Standby Mode [ ]

Description
Parameter Description
Standby Mode Turn on or turn off the function.
e @:0n
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Parameter Description

o (. Off

7.3.2.9 Restart Device

Restart the device.
Prerequisites

None
Notes

None

Interface Example

Description

Click Restart, and then click Yes in the displayed dialog box.

7.3.2.10 Configure Input Source Backup

Establish a backup relation for two input sources.
Prerequisites

None
Notes

Input backup rules:

® |n each backup group, two input sources serve as the backup for each other.
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® The backup relation can only be established if the input connectors have identical capacities.
® The USB source supports the input backup settings.

® FEach primary or backup source can have only one backup or primary source.

® Restrictions on input backup functions:

Input sources A and B form a hot backup group. The current input source of the layer is
input source A.

- Input A: No signal. Input B: Signal

The layer input source is switched to input B automatically. When input A resumes and
input B still has a signal and Primary Source Preferred is not enabled, the layer input
source will not be changed.

- Input A: No signal. Input B: Signal

The layer input source is switched to input B automatically. When input A resumes, but

input B does not have a signal, the layer input source will be changed to input A.
- Input A: No signal. Input B: No signal

The layer input source will not be changed.
- Input A: Signal. Input B: No signal

If you manually switch the layer input source to input B, the source will automatically
switch to input A.

Interface Example

Backup Status

v Primary Source Preferred ®

+ Add

Primary Source Backup Source

HDMI 1 HDMI 2

Delete

Description

Step 1 Select the Input Source Backup tab.
Step 2 Toggle the switch next to Backup Status to @0.

Step 3 Select or deselect Primary Source Preferred.
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® |f Primary Source Preferred is enabled, the system will automatically switch to the primary

source once it is restored.

® |f Primary Source Preferred is disabled, the system will not automatically switch when the

primary source is restored and will continue using the backup source.
Step 4 Click Add to add a backup relationship.

Step 5 Select a primary source and a backup source respectively from two drop-down lists to establish

a hot backup pair.
The green dot @ indicates the source is accessed normally and ready for use.

® To delete a hot backup pair, click . next to the pair and click Delete.

® To delete all hot backup pairs, click El

7.3.3 Configure Input Properties
Click the target input connector on the graphical device rear panel, and then set the input-

related properties in the property area on the right pane.

Figure 7-9 Input properties (VX2000 Pro)

VX2000 Pro

J 000 £33 £330 C303 C303 C303 0303 00 00 00
oOpe 290 © _—

7.3.3.1 View Input Source Info

View the basic properties of the input connector and change the input connector name.
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Prerequisites

A fine signal is connected to the input connector.

Notes

None

Interface Example

v Source Information

Connector Name

Type HDMI 2.0
Resolution © 3840=2160 px

Frame Rate 60 Hz
Bit Depth 8bit
Color Spacel/Sample RGB 4:4:4
Gamut Rec709
Quantization Range Full
Dynamic Range SDR
Metadata h
HDCP HDCP 22

Description

On the Basic tab interface, change the connector name as required.

E Note

Hover the mouse over the target input connector, you can view the input source resolution, frame

rate, bit depth and color/sampling rate.

7.3.3.2 View OPT Source Info

View the basic properties of the OPT source and change the OPT port name.

Prerequisites

® The device working mode is set to Video Controller.

® OPT 1 and OPT 2 is connected to the OPT ports on the front-end video processor via optical

fiber cables. Additionally, a fine signal is connected to the front-end device.
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Notes

Each OPT support the transmission of 1x DL or 2x SL sources.

Interface Example

v OPT1-1

Connector Name OPT11

Type OPT
Resolution (&) 1920=1080 px
Frame Rate 60 Hz

Color Space/Sample RGB 444

> OPT1-2

> OPT241

> OPT2-2

Description

On the Input Source tab interface, change the connector name as required.

7.3.3.3 Set Input Connector Capacity

Switch the input connector capacity as desired.
Prerequisites
None
Interface Example
When a connector is configured for hot backup, you can no longer switch its capacity.

Interface Example

Capacity
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Description

Capacity Description

SL ® Standard resolution: 1920x1080@60Hz
® Custom max width: 2048 (2048x1080@60Hz)
® Custom max height: 2048 (1080x2048@60Hz)

DL ® Standard resolution: 3840x1080@60Hz/3840x2160@30Hz
® Custom max width: 4096 (4096x1080@60Hz)
® Custom max height: 3840 (1080x3840@60Hz)

4K ® Standard resolution: 4096x2160@60Hz/8192x2160@30Hz
® Custom max width: 8192 (8192x1080@60Hz)
® Custom max height: 8188 (1080x8188@60Hz)

7.3.3.4 Configure Input HDCP

Enable or disable the input HDCP encryption.
Prerequisites

None
Notes

None

Interface Example

Description

For an HDCP source, it can only be properly recognized if the HDCP function on the input end is
enabled; if the input HDCP is disabled, the HDCP source will by default display a black screen or

SNOW.

For a non-HDCP source, whether the HDCP function on the input end is enabled or not does

not affect the normal transmission of the source image into the device.
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7.3.3.5 Configure InfoFrame Override Parameters

Configure the InfoFrame override parameters of the input source, so that the device can use it
when doing some calculations. This action does not change the parameter values that come

with the input source.
Prerequisites

None
Notes

None

Interface Example (VX2000 Pro)

v InfoFrame Override
Color Space/Sample From Input

Bit Depth From Input

Quantization Range From Input

Gamut From Input

Description

On the Basic tab interface, configure the following parameters.

Parameter Description

Color The sampling format of the input

Space/Sample

Bit Depth The bit depth of the input, i.e., the binary digits to represent a single color
Quantization The quantization range of the input

Range

Gamut The color gamut standard

Select From Input and the device will read the attribute values that come with the input source.
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7.3.3.6 Set HDR

HDR is the abbreviation for High-Dynamic Range. HDR function can greatly enhance the display
image quality, allowing for a more clear and vivid image when the device is used together with

the specified receiving cards.

Prerequisites

Use the layer 1 source as an HDR source.

® An HDR source (HDR10/HLG standard) must be used to realize optimal HDR effect.

Notes

® An HDR source can be connected to the HDMI 2.0 or 12G-SDI connector only.

The HDR and 3D functions cannot be used together.

Using the HDR function paired with receiving cards of different models will reduce the
device loading capacity by half or quarter because the HDR input source is 10-bit. Please

work out a connection solution in advance.

Interface Example

v HDR

Dynamic Range From Input

Description
Parameter Description
Dynamic Range The dynamic range of an HDR source

The supported options include HDR10, HLG, off

and From Input.

After the HDR source parameters are successfully set, you need to adjust EOTF. For detailed

operations, please refer to Adjust EOTF.

www.novastar.tech 113



NOVASTAR VX Pro Series All-in-One Controller User Manual

B Note

When you enable the HDR function, the receiving card supporting this function should be used
together. For the specified receiving card model and related information, please refer to our

official website (www.novastar.tech).

7.3.3.7 Configure EDID

Configure the resolution and frame rate of the input. You can select the standard resolution

provided by the device, customize a resolution, or set the advanced parameters.

Prerequisites

® SDI does not support this function.

® The front-end device outputs the video source from the graphics card.

Notes

It is recommended the advanced settings be carried out by the trained personnel only.

Interface Example

Figure 7-10 Standard

~ EDID

Mode Standard
Advanced

Resolution © 38402160

[ ] Display Resolution Details
Frame Rate 60.00 Hz ~

Apply

Figure 7-11 Custom

Mode Custom

Resolution ~  H 2160

Frame Rate . Hz ~

Apply
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Figure 7-12 Advanced

Mode

H Total

H Active

H Front Porch
H Sync

H Polarity

V Total
V Active

V Front Porch

V Sync

V Polarity

Frame Rate

Description

On the EDID tab interface, select the Standard, Custom or Advanced mode, configure the

following parameters, and then click Apply after the settings.

Mode

Parameter

Description

Mode

Three modes are supported, including Standard, Custom or

Advanced.

Standard

Resolution

The number of horizontal pixels and vertical pixels of the image

Check the box next to Display Resolution Details to display the
resolution detailed information.

Config method: Select the desired resolution from the drop-down

list.

Frame Rate

The image frames every second (unit: Hz)

Config method: Select the standard common frame rates from the
drop-down options. The available frame rates may vary according

to the chosen resolution.

Custom

Resolution

The number of horizontal pixels and vertical pixels of the image

Config method: Stet the width and height values respectively.

Frame Rate

The image frames every second (unit: Hz)

Config method: Select the standard common frame rates from the
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Mode Parameter Description
drop-down options. The available frame rates may vary according
to the chosen resolution.
Advanced | H Total Total pixel count per line
H Active The horizontal size in pixels of the active area

H Front Porch

The offset between the end of the active area and the beginning of

the H sync
H Sync The horizontal sync width in pixels (or between pixels)
H Polarity The polarity of the horizontal sync pulse
V Total Total pixel count per column
V Active The vertical size in pixels of the active area

V Front Porch

The offset in lines between the end of the active output area and

the beginning of V sync

V Sync The vertical sync width in rows (or between rows)
V Polarity The polarity of the vertical sync pulse
Frame Rate The image frames every second (unit: Hz)

Config method: Select the standard common frame rates from the

drop-down options or set the frame rate value.

7.3.3.8 Configure Compatibility with Mac

When the device is incompatible with the EDID of a Mac system, you may activate this feature

to resolve the issue.

Prerequisites

None

Notes

None
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Interface Example

* Mac Settings

Mac EDID Compatibility

Description
Parameter Description
Mac EDID Compatibility Turn on or turn off the function.
o« @ 0n
o (I off

7.3.3.9 Import and Export EDID

When compatibility problem occurs on an input connector, import an intact EDID file into the
device; or export an EDID file from a device and provide the EDID file to other devices or input

connectors to solve the compatibility issues.
Prerequisites

SDI does not support this function.
Notes

® FEach input connector supports importing one EDID file only.

® Once the EDID file is imported, the input connector will recognize and apply the parameters

from the file.

Interface Example

v EDID Import/Export
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Description

® EDID Import

On the EDID tab interface, click EDID Import. In the dialog box that appears, select an EDID

file and click Open.

® EDID Export

On the EDID tab interface, click EDID Export. In the dialog box that appears, select a path

and click Save.

B Note

If you need to modify the content of an imported EDID file, just modify it and then re-import it to

overwrite the original one.

7.3.4 Configure Output Properties

7.3.4.1 Set OPT Ports

Set the OPT working mode and loop mode.

Prerequisites

The device working mode is set to Video Controller.

Notes

None

Interface Example

OPT3/4 Working Mode Backup

OFT Loop Mode

Description

Click the OPT port on the device rear panel, and then set the following parameters.
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Table 7-1 OPT working mode

Device Model Parameter Description
VX400 Pro OPT 2 Working OPT 2 working mode
Mode

Config method: Select Copy or Backup from the drop-down
list.

® Copy: OPT 2 copies the output on Ethernet port 1~4.
® Backup: OPT 2 backs up the output on Ethernet port 1~4.

VX600 Pro OPT 2 working mode

Config method: Select Copy or Backup from the drop-down
list.

® Copy: OPT 2 copies the output on Ethernet port 1~6.
® Backup: OPT 2 backs up the output on Ethernet port 1~6.

VX1000 Pro OPT 2 working mode

Config method: Select Copy or Backup from the drop-down
list.

® Copy: OPT 2 copies the output on Ethernet port 1~10.

® Backup: OPT 2 backs up the output on Ethernet port
1~10.

VX2000 Pro OPT 3/4 Working | OPT 3 and OPT 4 working modes

Mode Config method: Select Copy or Backup from the drop-down

list.
® Copy: OPT 3 and OPT 4 copy the output on Ethernet port
1~10 and 11~20 respectively.

® Backup: OPT 3 and OPT 4 back up the output on Ethernet
port 1~10 and 11~20 respectively.

E Note

o After the OPT working mode is set to Copy, the OPT ports on the graphical device panel will be
highlighted.

o After the OPT working mode is set to Backup, the backup icons will be displayed at the bottom
right corner of the OPT ports on the graphical device panel.

Table 7-2 OPT loop mode

Device Model Parameter Description

VX400 Pro/VX600 | OPT Loop Mode Turn on or turn off the function.
Pro/VX1000 e On @
Pro/VX2000 Pro
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Device Model Parameter Description
After this function is enabled, the video signal accessed
by OPT 1 will be looped out via OPT 2.
e Off: (I
7.3.4.2 Set Monitoring

Real-time display of the output image via the monitor connected is supported. You can monitor

whether the output is normal and adjust the display ratio of the monitoring image on the

monitor to avoid image distortion.
Prerequisites

None
Notes

Interface Example (VX2000 Pro)

v Monitor Settings

Mode FULL SCREEN Keep Ratio

Definition Smooth HD

Description

Click the Monitor connector on the device rear panel, and then set the following parameters.

Parameter Description

E Note

Scaling Mode The options include Keep Ratio and Full Screen (default).
® Keep Ratio: Keep the ratio of the original output image to display.

® Full Screen: Display the output image in full screen.

When Keep Ratio is selected, the blank area that the output image cannot

cover the entire monitor screen will be automatically filled with solid black.

Definition The supported options include Smooth and High-Definition.
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Parameter Description

® Smooth: The monitoring image definition is 1920x1080@60Hz.

® High-Definition: The monitoring image definition is 3840%2160@60Hz.

7.4 Screen Configuration

7.4.1 Configure Sub-Screens

When a single device is used to load to multiple physical screens (for example, to display the
same or different content simultaneously on multiple welcome screens or information screens),
the sub-screen function can be enabled. By configuring an independent sub-screen for each

physical screen, their display effects can be controlled separately.

7.4.1.1 Add Sub-Screens

Configure an independent sub-screen for each physical screen, allowing for independent

control of the images and effects on each screen.
Prerequisites

None
Notes

Up to 5 sub-screens can be created.
Interface Example

Sub-Screen 1 v

Sub-Screen 1

-+Mew Sub-Screen
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Description

Click Sub-Screen at the top right corner, and then click New Sub-Screen in the popup menu to

add a sub-screen. The default name is Sub-Screen 1.

E Note

If you have configured the screen topology before adding a sub-screen, the configured cabinets

will be automatically assigned to the first created sub-screen by default.

In the sub-screen list, you can perform the following operations.

® Change name: Hover the mouse over the target sub-screen, and then click that appears.
Enter a new name, and then click elsewhere in the interface to complete the sub-screen

name change.

® Delete sub-screen: Hover the mouse over the target sub-screen, and then click that

appears. In the popup dialog box, click OK to delete the sub-screen.

E Note

® When deleting a sub-screen, its configured cabinets will also be deleted. Please proceed

with caution.

® When deleting the last sub-screen, its screen topology will be saved to the initial screen.

7.4.1.2 Set Sub-Screens

For a sub-screen, you can perform related operations, including screen topology configuration,
cabinet correction and screen adjustment, realizing independent control of each physical

screen.

Prerequisites

None

Notes

® |f you use the quick configuration function to configure the LED screen on the device LCD

panel, all sub-screens created in Unico will be cleared.
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® You can add, delete or rename a sub-screen on the Screen interface only. For switching or
configuring the sub-screen, please perform the related operations on the Correction or

Screen Settings interface.

Interface Example

Sub-Screen 1 v
Sub-Screen 1

-+New Sub-Screen

£ LCT lite

Description

Click Sub-Screen at the top right corner, and then select the target sub-screen to switch to it.

After switching to the target sub-screen, you can configure the screen topology, correct the
cabinet and adjust the screen on the Screen, Correction or Screen Settings interface

respectively. For detailed operations, please refer to the related sections in this manual.

E Note

® On the Screen interface, cabinets configured for all sub-screens will be displayed, and the

cabinets of the current screen will be displayed at the top and can be selected; while,
cabinets of other sub-screens will be displayed in gray at the bottom and cannot be

selected.

® On the Correction and Screen Settings interfaces, only cabinets of the current sub-screen

will be displayed.

® On the Screen Settings interfaces, click Sub-Screen at the top right corner, and then select
All in the popup menu to adjust the related parameters, such as brightness and Gamma, for

all sub-screens.
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7.4.2 Configure Screen Topology

Configure the cabinet topology to complete the wiring connections of the physical or empty

cabinets.

7.4.2.1 Configure Online Cabinets

Prerequisites

The device is connected and cabinets are connected to the device.
Notes

None
Description

Step 1 Click Screen at the top to enter the screen configuration interface.

Figure 7-13 Screen configuration (VX2000 Pro)

£ LCT e 1 Add Cabinet

CRetesn  # Switlayout  Mapping @)

Step 2 Select the desired screen from the screen list on the left.

Step 3 In the Ethernet Port List area, select an Ethernet port and then drag and click the mouse in the

topology area to add cabinets.
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The cabinets will be automatically connected when you are adding them, as shown in Figure 7-

14. The Ethernet port's loading capacity information will be displayed, as shown in Figure 7-15.

Figure 7-14 Cabinets connected automatically

Device 1

Figure 7-15 Ethernet port capacity

o 28

1

20%

® 1: The Ethernet port number

® 2/8: Configured cabinets loaded by this Ethernet port/Total cabinets loaded by this Ethernet
port

20% and progress bar: Loading capacity used by the configured cabinets/Total loading
capacity of this Ethernet port

E Note

Descriptions for shortcut keys:

e Batch select cabinets: Hold the Shift key and drag with the left mouse button to select, or
simply drag the mouse to select multiple cabinets at a time.

e When no Ethernet ports are selected, use the arrow keys to finely adjust the position of the
selected cabinet. Each press moves the cabinet by 1 pixel.

Description for Swift Layout:

e Requirements: If all the cabinets loaded by the Ethernet ports have the same model, resolution,
and connection topology, you can use the Swift Layout function to quickly add and connect
the cabinets for all the Ethernet ports.

e Operating procedure: Click and then drag the mouse in the topology area to add
cabinets that match the actual requirements. In the properties area, select a layout and click

Done.

Step 4 Select other Ethernet ports and continue to add cabinets until all cabinets are connected.
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Step 5

Step 6

E Note

The configured cabinets can be rewired by selecting other Ethernet ports to load them.

For cabinets that have the same size and consecutive serial numbers, if you want to change the
cabinet connection topology, select the cabinets and then select a quick topology under Quick
topo in the properties area, as shown in Figure 7-16. For other cabinets, skip this step.

Figure 7-16 Quick topology

Quick Topo

mn Ul

NN U

Do any of the following to arrange and align the cabinets and cabinet groups to let the cabinet

positions meet the display requirements.

® Use the function buttons.

Zoom to Selection  Grid Align Left Locked/Unlocked

I

Undo Redo ZoomIn Zoom Out AutoFit  Clear Topology Arrange Left

- Zoom to Selection: The selected element is zoomed and displayed in the center of the

canvas.

- Auto Fit: The canvas size is automatically adjusted to fit the topology area size.

- Click B to show its drop-down menu shown below. The menu can be used to set the

canvas grid.
Grid
Grid Color

Grid Spacing

X 192 px O Y 192 px

Snap to Cabinet

Snap to Grid

Grid: When toggled on (@), a grid is displayed on the canvas. If you do not need to
display the grid, set the switch to .

Grid Color: Set the grid color.
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Grid Spacing: Set the spacing of horizontal and vertical lines of the grid. The spacing is

set to the resolution of the first cabinet by default.

Snap to Cabinet: When positioning a cabinet near another one, the cabinet being
moved will automatically align and snap to the edge of the adjacent cabinet, effectively

eliminating gaps.
Snap to Grid: The cabinet will be snapped to the grid.
® Use the right-click function menu
- Select String: Select all the cabinets on the connection line of the current cabinet.

Select Same Cabinets: Select the cabinets of the same model of the current cabinet.

Blackout: Blackout the output image displayed on the current cabinet.
- Freeze: Freeze the output image displayed on the current cabinet.

- Swap: Swap the positions of the two selected cabinets.

Group: Select the desired cabinets and right click on them. Click Group in the context
menu, and then the selected cabinets will be grouped for batch control. To set the
group name and color, please select the group and set them in the properties area. You

can also use the keyboard shortcuts Ctrl+G to perform the grouping operation.

Ungroup: Ungroup the cabinets. You can also use the keyboard shortcuts Ctrl+Shift+G

to perform this action.
- Add to: Add the selected cabinets to a group.

- Clear Topology: Clear the current cabinet topology.

Delete: Delete the selected cabinet. You can also use the keyboard shortcuts Del to

perform this action.

® Right click on the canvas edge and use the function menu
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Fit Screen

Zoom 11

Display Grid

Snap to Grid

Snap to Cabinet

Display Topology

Display Status

Display Cabinet Color

Display Group Name

Display Overlapping Cabi. .

- Zoom to Selected: The selected element is zoomed and displayed in the center of the

canvas.
- Fit Screen: The canvas size is automatically adjusted to fit the topology area size.
- Zoom 1:1: The canvas size equals the input source resolution.
- Display Grid: Display a grid on the canvas.
- Snap to Grid: The cabinet will be snapped to the grid.

- Snap to Cabinet: When positioning a cabinet near another one, the cabinet being
moved will automatically align and snap to the edge of the adjacent cabinet, effectively
eliminating gaps.

- Display Topology: Display the cabinet connections.
- Display Status: Display the cabinet status.
Green: The cabinet is in the topology area.
Gray: The cabinet is offline.
Orange: Some part of the cabinet is in the topology area.
Red: The entire cabinet is out of the topology area.

- Display Cabinet Color: Display a color icon at the top right corner of an Ethernet port.
Once an Ethernet port is loading cabinets, a color icon will be displayed which is of the

same color as the cabinet color.
- Display Group Name: Display the cabinet group name.

- Display Overlapping Cabinets: Display the overlapping cabinets.
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Figure 7-17 Online cabinet topology (VX2000 Pro)

OLCT e

B Note

e Use either Unico or NovaLCT to configure the screen.

e Mapping is used to show the relations between the cabinets of the LED screen and the
sending devices so that you can view or check the connections between the cabinets.

e Click LCT Lite to run the software in which you can configure the receiving card parameters.

e Inthe menu bar, go to File > Export Screen Config File to export the configured cabinet
topology as a file (.scr).

e Inthe menu bar, go to File > Import Screen Config File to import a saved screen configuration

file for quick topology.

7.4.2.2 Configure Empty Cabinets

Prerequisites
None
Notes

None
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Description

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Click Screen at the top of the page to enter the screen configuration page.

Figure 7-18 Screen configuration (VX2000 Pro)

£ LCT e 1 Add Cabinet

CRetesn  # Switlayout  Mapping @)

Select the desired screen from the screen list on the left.
Click Add Cabinet.

Figure 7-19 Add cabinets

Add Cabinet

Select Mode

Custom

Cabinet Resolution

w192

Amangement

Rows 3

Select the desired cabinet existing in the cabinet library from the drop-down list below Select
Mode.

(Optional) If no cabinet configuration files (.rcfgx) are imported to the cabinet library, you can

set the width and height for the empty cabinet.
Set the rows and columns of cabinets. After settings are done, click OK to confirm.

In the topology area, click the left mouse button to add cabinets with the set rows and columns.
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Figure 7-20 Add empty cabinets (VX2000 Pro)

Step 8 Select the desired Ethernet port and drag or click the mouse in the empty cabinets to complete

the wiring.

E Note

Descriptions for screen topology:

e Use format painter.

Method I: Select an Ethernet port first, and then select the desired data flow. The cursor will
change to a format painter icon. Drag the mouse in the empty cabinets to automatically

complete the wiring according to the selected data flow.

Method II: Select the desired data flow first, and the cursor will change to a format painter
icon. Then, select an Ethernet port and drag the mouse in the empty cabinets to complete

the wiring according to the selected data flow.
e Drag the mouse to complete the wiring.

After selecting an Ethernet port, there is no need to choose the data flow. Simply drag the
mouse in the empty cabinets, and the system will automatically complete the wiring

according to the mouse movement.
e Quick topology

Select one or multiple empty cabinets, select the desired data flow, and then select the

target Ethernet port to complete the wiring.

e Use arrow keys.
Select an Ethernet port and confirm the wiring starting position, and then use arrow keys to

control the wiring path.

www.novastar.tech 131



NOVASTAR VX Pro Series All-in-One Controller User Manual

Step 9 Select other Ethernet ports and continue wiring until all cabinets are connected.

Figure 7-21 Empty cabinet topology (VX2000 Pro)

LCT ke P Agd Cabinet

(=] Port Listai4n) CReesh  # Swillayeut | Magping @

Cabinet connection status:
® P1:The cabinet is loaded by Ethernet port 1.

® NC: An empty cabinet

Step 10 Connect the on-site cabinets based on the configured topology.

E Note

When configuring the empty cabinet, you can leave the desired cabinet without wiring as shown

below based on the on-site screen loading requirements.

Device 1

7.4.3 Configure Screen Properties

Set the screen-related properties in the property area on the right pane.
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7.4.3.1 Rename Screens

Change the screen name.

Prerequisites

None

Notes

None

Interface Example

Vv Basic Info

Screen Name Screend

Screen Category

Resolution ()

Description

On the Basic tab interface, change the screen name as required.

7.4.3.2 Configure Low Latency

When the input source travels from where it comes to the processing device, sending device

and then the receiving card, latency exists inevitably. Turning on this function can effectively

help to reduce the latency from the input to output.

Prerequisites

None

Notes

If you set the low latency mode to Auto, the system will determine whether to enable the low

latency based on the screen topology. The specific rules are as follows.
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® For asingle Ethernet port with vertical cabling and no overlap in the Y direction, the low
latency will be automatically enabled if all the following requirements are met; otherwise, it
will be disabled.

- The cabinets loaded by one Ethernet port cannot be overlapped, while blank

configurations are allowed.

- The circumscribed rectangles of all cabinets loaded by Ethernet ports must be aligned

at the top of the canvas.

- No need to keep the same cabinet size.

Port 1 W ‘Porln|
o S .

® For free topology, the low latency will be automatically enabled if all the following

requirements are met; otherwise, it will be disabled.

- The cabinets loaded by one Ethernet port cannot be overlapped, while blank

configurations are not allowed.

- The circumscribed rectangles of all cabinets loaded by Ethernet ports must be aligned
at the top of the canvas. The size of the circumscribed rectangle cannot exceed 650,000

pixels.

-~ The size of all cabinets must be the same.

Interface Example

v Screen

Low Latency

Processor Latency (D) 2 frame(s)

Description
Parameter Description
Low Latency Turn on of turn off the function.
® Off: Turn off the function. (Default option)
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Parameter

Description

® On: Turn on the function. The device latency can be reduced by 1 frame.

E Note

After you manually enable the low latency function, it is advisable to align the
circumscribed rectangle loaded by each Ethernet port at the top of the canvas. If
not aligned, the loading capacity will be reduced. For calculating the actual loading
capacity, please refer to Loading Capacity Calculation Method in Low Latency
Mode.

® Auto: If you set the low latency mode to Auto, the system will determine
whether to enable the low latency based on the screen topology. If the wiring
meets the rules, low latency will be enabled automatically; otherwise, it will be
disabled automatically. For specific rules, please refer to the notes in this

section.

7.4.3.3 Set Canvas Size

Prerequisites

None

Notes

None

Interface Example

v Canvas

Configured Cabinet

576 >384

3840 x 2160

Description

On the Basic tab interface, configure the following parameters.

Parameter

Description

Resolution

The size of the canvas, that is the size of the device effective loading area

www.novastar.tech

135




NOVASTAR VX Pro Series All-in-One Controller User Manual

Parameter Description

Config method:
® Select the desired resolution from the drop-down list.

® Select Custom from the drop-down list, and then set the width and height

values.

Generally, the size of the effective loading area should match with that of the

physical screen.

After you complete the settings, the system will automatically calculate the max

output frame rate at the current resolution.

Match Screen After the screen configuration is completed, click Match Screen and the system
will automatically change the canvas size to the size of the circumscribed

rectangles.

71.4.3.4 Configure Test Patterns

Test patterns are used to check the connection relation between the output connectors and the

screen, and check whether the screen display is good.
Prerequisites
None

Notes

None

www.novastar.tech 136



NOVASTAR VX Pro Series All-in-One Controller User Manual

Interface Example

~ Test Pattern

[
I

Grayscale
Spacing (px)
Grid Width

Speed

Description

On the Basic tab interface, configure the following parameters.

Parameter Description
Test Pattern Turn on or turn off the function.
o« @ 0n
o (O off
After the function is enabled, select the desired test pattern.
Grayscale Set the grayscale of the test pattern.
Spacing Level Set the spacing between different color areas.

If a multi-color test pattern is selected, this parameter is available.

Spacing (px) Set the spacing between the lines.

If a grid test pattern is selected, this parameter is available.

Grid Width Set the width of the grid lines.

Speed Set the moving speed of the lines.
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7.4.3.5 Configure Output Color

Configure the output color parameters.

Prerequisites

None

Notes

None

Interface Example

v Color

Contrast ©

ConfrasiR 2

ConfrastG £

ConfrastB £

Brightness £

BrighinessR 2

BrightnessG *=

BrightnessB £

—e

Saturation *=

—e
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Description

On the Effect tab interface, configure the following parameters.

Parameter Description

Contrast The ratio of the luminance of the brightest color to that of the darkest color
Adjust the contrast value either as a whole or individually adjust the RGB
components.

Brightness The shading of lights in the image
Adjust the brightness value either as a whole or individually adjust the RGB
components.

Hue The relative degree of how bright or dark the image is

Saturation The color purity of the image
The higher the value, the more vivid the color.

7.4.4 Configure Cabinet Properties

7.4.4.1 View Cabinet Library

Prerequisites

None

Notes

None
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Interface Example

“ Cabinet Library

Online Local

B 192 x 192

Description

View the online cabinets or cabinet configuration files in the cabinet library.

Click Add to upload the cabinet file to the local pack or device pack, or add the virtual cabinet

to the local pack. For detailed operations, please refer to Manage Cabinet Library.

7.4.4.2 Change Cabinet Resolutions

Prerequisites
None
Notes

The changed resolution of the configured cabinet should be a multiple of the module resolution

to ensure normal display.

Interface Example

v Cabinet Resolution

w 192 px o
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Configuration

Select the desired cabinet in the canvas area, and then set the cabinet width and height on the

Cabinet Properties tab interface. After settings are done, click OK to complete the editing.

7.4.4.3 View Cabinet Info

View cabinet-related info.

Prerequisites

None

Notes

None

Interface Example

v Cabinet
Manufacturer
Type
Cabinet Size —
Pitch 1.000mm
Cabinet Resolution 192=192 px
Module Resolufion 128=64 px

Other W

Driver Chip

Decoder

Module Arrangement

Refresh Rate

Grayscale

Description

None

ICND2065
DecodelCN2012_IC
64scans

Horizontal

960Hz

12bits
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71.4.4.4 Configure Cabinet Groups

Change the cabinet group name and background color.
Prerequisites

A cabinet group has been created.
Notes

None

Interface Example

v Cabinet Group

Group Group1

Color

Description

On the Cabinet Properties tab interface, configure the following parameters.

Parameter Description

Group The name of the cabinet group

Config method: Enter a new group name, and then click elsewhere in the

interface to complete the group name change.

Color The background color of the group name

Config method: Click the color block next to Color, and then select a standard

color or enter RGB values to set the background color of the cabinet group name.

7.4.4.5 Configure Cabinet Positions

Prerequisites

None
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Notes

The cabinet rotation in 90° increments feature is only supported by certain models of receiving

cards, as detailed below:

Model Description
CAS50E, XA50Pro, A10s Pro Supported by all versions.
A8s-N, A7s Plus, A5s Plus Supported by V4.9.0.0 or later.

Interface Example

~ Cabinet Position
Coordinate

X 0

Rotation {0°)

Description

On the Cabinet Properties tab interface, configure the following parameters.

Parameter Description

Coordinate The position of the cabinet on the canvas
® X: X coordinate of the cabinet on the canvas

® Y:Y coordinate of the cabinet on the canvas

Rotation (0°) Rotate the cabinet. Once the cabinet is rotated, the input source will display at
the adjusted angle.

Supported rotation angles: 0°, 90°, 180° and 270°

71.4.4.6 Set Cabinets

Prerequisites

None

Notes

None
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Interface Example

v Cabinet Settings

Blackout
Freeze
Indicator

Light up slowly

Test Pattern . Nomal

No data signal Prestored Image

Description

On the Cabinet Properties tab interface, configure the following parameters.

Parameter Description

Blackout Turn on or turn off the function.
° (): On
o OB Off

Freeze Turn on or turn off the function.
. (): On
o (OB Off

Indicator Turn on or turn off the function.
° I(:): On
o OB Off

Light up slowly Turn on or turn off the function.
e @:0n
o (I off

Once enabled, the display brightness will slowly change from 0 to the target value

after the screen is powered on.

Test Pattern Select a test pattern to perform screen aging test and troubleshoot problems.

No data signal Set the display image after the Ethernet cable is disconnected.
® Blackout: The screen displays a black image.

® Previous Frame: The screen always displays the last frame.
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7.4.4.7 Configure Ethernet Port Backup

Test whether the pre-stored images, backup Ethernet ports and devices take effect without

plugging and unplugging the Ethernet cables.

Prerequisites

The pre-stored images, primary and backup Ethernet ports or primary and backup devices have

been configured.
Notes
None

Interface Example

v Port Backup

Backup Verify

Description

On the Cabinet Properties tab interface, configure the following parameters.

Parameter Description

Port Backup Turn on or turn off the function.
e @:0n
o (. off

Backup Verify Select the desired backup test.

® Off: Enable the output of all the Ethernet ports on the current device to

complete the test.

® Backup: Disable the output of the primary Ethernet port on the current device

to test whether the backup port or device takes effect.

® Primary: Disable the output of the backup Ethernet port on the current device
to test whether the output of the primary port is normal.

® Disconnect All: Disable the output of all the Ethernet ports on the current

device to test whether the pre-stored image takes effect.
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E Note

After enabling Ethernet port backup, a icon is displayed between the primary and backup
ports in the Ethernet port list. By default, the first half of the ports serve as backups for the

second half.

7.4.4.8 Set Dual RV Cards Backup

Receiving card backup allows you to set the backup relationship between two receiving cards. If
the primary receiving card link fails, the backup one will take over the responsibilities of the

primary receiving card and continue to work well to ensure the LED screen will not go black.
Prerequisites

Two receiving cards are connected to the cabinet.
Notes

When you enable both the device backup and dual receiving cards backup, the former takes
precedence over the latter. When the layer sources of two devices are disconnected, the device

will switch to the backup receiving card link.

Interface Example

Dual RV Cards Backup ®

Description
Parameter Description
Dual RV Cards Backup Turn on or turn off the function.
o« @:0n
o (. off
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7.5 Screen Correction

7.5.1 Correct Seams

Adjust the seams between cabinets or modules to improve the display effect.
Prerequisites

You have configured the cabinets.
Notes

None
Description

Step 1 Select Correction at the top of the page.

Figure 7-22 Screen correction

Step 2 On the Seams tab in the properties area, toggle the Brightness Calibration switch to .
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Step 3

Step 4

E Note

Only the specific receiving cards support the Seam Correction switch, including the A8s Pro,
NV7508, NV7512, NV7516, DH7508-S, DH7512-S, DH7516-S and MRV208-NB7s. The
adjustment of bright and dark lines can be controlled independently of the coefficients.
When turned off, the bright and dark lines cannot be adjusted, and any previously made

adjustments will not be displayed.

Apart from the above-mentioned receiving cards, the Seam Correction switch will not be
displayed on this interface. In this case, simply toggling on the Brightness Calibration or

Brightness and Chroma Calibration will ensure that the seam correction takes effect.

Toggle on Brightness Calibration or Brightness and Chroma Calibration to view the

correction effect.

Brightness Calibration: Set the Brightness Calibration switch to @ to make the screen
apply the calibration effect made by the calibration platform.

Brightness and Chroma Calibration: Set the Brightness and Chroma Calibration switch to

@ to make the screen apply the calibration effect made by the calibration platform.

The Brightness Calibration and Brightness and Chroma Calibration are mutually exclusive.

Figure 7-23 Correction (seams)

v Correction

Brightness Calibration

Brighiness and Chroma Calibration

Select a correction mode.

Figure 7-24 Select mode (seams)

v Select Mode

Cabinet Seams LDM Seams Cabinet

(F1) (F2) (F3) ;4_} ;:} (FB) (F9)

Cabinet Seams: Correct the seams of cabinets.

LDM Seams: Correct the seams of modules.

E Note

You can use the corresponding shortcut keys to quickly select the target one. For example, press

F1 to select all outer border lines of the cabinet.
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Step 5 When correcting the module seams, if you need to override the numbers of module columns
and rows, click the - icon next to Select Mode and then perform the settings on the Cabinet

Structure Override window. Otherwise, skip this step.

Figure 7-25 Cabinet structure override

Cabinet Structure Overnde

Cabinet Structure
Override

LDM Cols

LDM Rows

Step 6 Set the screen display parameters and check the seam correction effect.
Figure 7-26 Adjustment (4-color)

v Adjustment

Brightness

e
H

(W)

® Brightness: Adjust the display brightness.

® Display image: Set the image displayed on the screen. By default, the current input source is

being displayed (.). You can switch to a monochrome display.

E Note

You can use the corresponding shortcut keys to switch between various images. For example,

press W to switch to white image display.

Step 7 In the topology area, click or click and drag the mouse to select the seams to be corrected.

Step 8 Set the adjustment parameters.
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Figure 7-27 Set the parameters

Brightness (1+ 1))

Quick adjust

Fine adjust

Hide the cursor while adjusting

Restore

® (Quick adjust: Has a large range of adjustment.
® Fine Adjust: Has a fine range of adjustment.

e Hide the cursor while adjusting: When this is enabled (#), the cursor will not be displayed

on the screen while adjusting brightness and chroma.

Step 9 Place the mouse on the scroll wheel icon and adjust the brightness by dragging the wheel icon

up or down, scrolling the mouse wheel, or using the keyboard shortcuts 1+ 1/ .

® Restore: Restore the configuration to the last saved.

® Reset: Reset the configuration to factory defaults.

Step 10 After the settings, click Save.

7.5.2 Erase Seam Correction

If there are any changes made to the cabinets, such as moving a receiving card from one
cabinet to another or replacing the cabinet module, it may cause bright or dark lines that had
been previously corrected to appear in the middle of the cabinet or module. In such cases, you

have the option to remove the seam correction that was applied.
Prerequisites

You have configured the cabinets.
Notes

None
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Description

Step 1 Select Correction at the top of the page.
Step 2 Select the Cabinet mode.

Figure 7-28 Select mode (cabinet)

v Select Mode

Cabinet Seams Cabinet

(F1) (F2) (F3) (F5) (FB) (F9)

Step 3 Select the target cabinets and then click Erase to remove the seam correction that was applied

to them. The erasion will be automatically saved to the hardware once you are done.

Figure 7-29 Erase seam correction

7.6 Screen Settings

7.6.1 Adjust Image Quality

7.6.1.1 Adjust Brightness and Gamma

Adjust the Gamma value and brightness of the output to enhance the overall image quality of
the LED screen.

Prerequisites

None
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Notes

None

Interface Example

v Brightness Adjustment

Brightness

Gamma

——

Description

Select Screen Settings at the top of the page, and then on the Image Quality tab interface,

configure the following parameters.

Parameter Description
Brightness The brightness of the LED screen
Gamma Adjust the ratio of the screen brightness to the input level. The parameters are

read from the receiving card, which default to optimal values at the factory. It is
recommended the parameter adjustment be carried out by the trained personnel

when necessary.

7.6.1.2 Set LED Image Booster

Set the LED Image Booster function to improve the delicacy and accuracy of the image color

and gradation and realize free switching of the display color gamut.

Prerequisites

Before the operation, color gamut and brightness correction by using the CA410-VP427,
CA410-P427 or CA410-P427H colorimeter must be done.

Notes

None
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Interface Example

v LED Image Booster

Gamut [l ]

Color Temperature
S 6500 K

Magic Gray [ ]

Description
Parameter Description
Gamut The color gamut standard
The output gamut options include standard
gamuts, custom gamuts, the original screen
gamut and the input gamut (From input).
To set the custom gamut, click E select a
gamut in the properties area on the color gamut
diagram, and adjust the red, green, blue and
white parameters based on the selected gamut.
Color Temperature Drag the slider to adjust color temperature.
Magic Gray Turn on or turn off the function.
o« @:0n
o (I Off
7.6.1.3 Adjust EOTF

Prerequisites

None

Notes

The supported adjustment parameters depend on the HDR source settings.
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Interface Example

* EOTF Adjustment

Shadow Compensation

e ———

Ambient Light Compensation

o r—

Clip Level

o

Peak Brightness Override

Peak Brightness

.— 100

Description

( Reset )

On the Image Quality tab interface, drag the sliders to adjust the related parameters.

Parameter

Description

Shadow Compensation

Adjust this parameter to enhance the image display effect. The greater the

value, the clearer the details in the shadow area.

Range: 0 to 100 (default: 33), Step: 1

Ambient Light

Compensation

Adjust this parameter to reduce the loss of image details caused by ambient
light diffusion.

Range: 0 (default) to 80, Step: 1

Clip Level

Adjust the parameter to reduce the screen overexposure and enhance

details of the highlight areas.
Range: 0 (default) to 100, Step: 1

Override Peak Screen
Brightness

Turn on or turn off the function.
® On: D
e Off: (I

Peak Screen Brightness

Adjust the brightness of the screen when it is functioning normally.

When Override Peak Screen Brightness is enabled, this parameter can be
adjusted. Range: 100 to 10000 nits (default: 1000 nits), Step: 1

www.novastar.tech

154




NOVASTAR VX Pro Series All-in-One Controller User Manual

7.6.2 Adjust Output

7.6.2.1 Set Output Bit Depth

Prerequisites
None
Notes

When you use the HDR function, setting output bit depth to 10bit is required to achieve optimal
display effect.

Interface Example

v Video

Bit Depth

Description

On the Output tab interface, configure the following parameters.

Parameter Description

Bit Depth Set the output bit depth.

The supported options include 8bit and 10bit.

7.6.2.2 Configure 3D

Directly connect a third-party 3D emitter using the device's built-in 3D connector, or connect to
the EMT200 Pro emitter via the device's Ethernet port. Then, use the compatible 3D glasses to
achieve a 3D display effect.

Prerequisites

® Video source format: Side-by side, top-and-bottom or frame sequential
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® When paired with the EMT200 Pro, it is recommended to use a 3D source of 60Hz to enjoy

an optimal experience.

Notes

® When the 3D function is enabled and the video source format is Side-by-Side or Top-and-

Bottom, the device output capacity will be halved.

® When the 3D function is enabled and the video source format is Frame Sequential, you need

to manually set the output frame rate which must be the same as the input frame rate.
® The 3D function and input cropping cannot be enabled at the same time.

® After enabling the 3D function on the Screen Settings page, 3D switches of all the layers will
be toggled on. If you want to use a 2D layer, please toggle off the 3D switch of the desired

layer in the property area of the Programming page.

® The 3D effect follows the layer. The output area where a 3D layer is located always displays
the 3D effect.

Interface Example

v3D@

Source Format Side-by-Side
Eye Priority Left
3rd Emitter

Signal Delay

Description

On the Output tab interface, configure the following parameters.

Parameter Description

3D Turn on or turn off the 3D function.
° (}: On
o O off

Source Format | The format of the 3D video source

Set the format to Side-by-Side, Top-and-Bottom or Frame Sequential according to

the format of the accessed video source.

Eye Priority Set which image is sent first, the right eye image or the left eye image.

Put on the 3D glasses to view the screen. If the display appears abnormal, adjust the
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Parameter Description

parameter value to the other one. If the display is normal, no further adjustments are

needed.
3rd Emitter Turn on or turn off the function.
o« @:0n
o (I off
Signal Delay Set the delay time of sending the synchronization signal from the 3D signal emitter to

the 3D glasses. This setting ensures that the switching between left and right eye
images of the 3D glasses is in sync with the switching between the left and right eye
images on the screen. This parameter is applicable to both the NovaStar and third-

party emitters.

7.6.2.3 Check Load

Check the capacity usage of each Ethernet port of the device.

Prerequisites

None

Notes

None

Interface Example

v Port Load

Device 1

Description

On the Output tab interface, click ! next to the device information to check the usage of the

device loading capacity.
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7.7 Layer Operations

7.7.1 Add Layers

Add layers to screen

Prerequisites

Make sure the device is in Video Controller mode before adding layers.

Notes

The maximum number of layers that can be added depends on the connected device.

Device Model Number of Supported Layers (2Kx1K)
VX400 Pro 6
VX600 Pro
VX1000 Pro
VX2000 Pro 12
Description

Step 1 Click Programming at the top of the page to enter the layer editing page. Select the desired

screen from the left screen list, and then click the Input tab.
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Figure 7-30 Programming (VX2000 Pro)

2 | Engish- Engish

v £35 Dovico 1
v W Mosaic Source

MOSAIC

v UDsk

UDisk

v Local

HOMI 1

Hom2
HoMI 3
HoML4
oM 5

HOMI6

Step 2 Add the layers to the screen.
Drag an input source in the input list to the screen.
Step 3 Perform the desired layer operations as required.

Figure 7-31 Layer operations

850w = 1 Lock/Unlock layer
Screent 2 Pixel-to-pixel display
3 Fill entire screen

4 Fill canvas

5 Follow canvas

6 Delete layer

000000 7 Zoom Out
@O NS a 8 Zoomn
9 Zoom to Selection
10 Auto fit

11 Lock/Unlock canvas

12 Adjust layer priority

13 Set layer filling mode

14 Set layer alignment method
15 Clear

16 Output image brightness
17 Set audio

18 FTB

19 Freez/unfreeze

7.7.2 Configure Video Source Properties

In the input list, select an input source and set the relevant properties on the right pane. For

detailed configurations and parameter descriptions, please refer to Configure Input Properties.
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7.7.3 Mosaic Source Settings

Both HDMI and OPT sources support mosaicing.

7.7.3.1 View Mosaic Source Info

View the basic properties of the mosaic source and change the source name.
Prerequisites

A mosaic source has been configured and its signal is fine.
Notes

None

Interface Example

v Mosaic Source Info

Name MOSAIC
Resolution 38401080
Frame Rate 60

Connector Capacity DL

Mosaic Template |:| |:|

v HDMI 3

Type HDMI 1.3
Resolution & 1920=1080 px
Frame Rate 60 Hz

Color Space/Sample RGE 4:4:4

> HDMI 4

Description

On the Mosaic Source tab interface, type in a new source name and click anywhere else on the
interface to save the change.
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7.7.3.2 Configure Mosaic Sources

Set the mosaic source name, sub-source type, mosaic layout as well as sub-source size.
Prerequisites

None
Notes

Only the input sources of the same connector type support mosaicing, and the frame rates of

sub-source must be the same.

Interface Example

v Mosaic Settings
Name MOSAIC

Source type HDMI 1.3

cawas. [ ][I = 000 £ &8 [l

Sub-Source Size

Width 1920 Z Height 1080

Description

On the Edit Mosaic tab interface, configure the following parameters.

Parameter Name | Description

Name The name of the mosaic source

Source Type The type of the sub-sources

Config method: Select HDMI 1.3, HDMI 2.0 or OPT from the drop-down list.

Layout The layout of the mosaic source

Config method: Select the desired layout from the standard layout template, and
then drag the inputs in the input list to the sub-cells respectively.

Sub-Source Size The size of the sub-sources
® Default width: 1920 pixels, max width: 8192 pixels
® Default height: 1080 pixels, max height: 8192 pixels
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Parameter Name | Description

® Max width and height: 4096x2160

7.7.4 Configure USB Source Properties

Select a USB source in the input list and configure relevant properties on the USB Playback

Settings tab interface.

The models of devices that support USB playback and the corresponding output resolutions for

USB sources are listed below.

Device Model USB Source Resolution
VX400 Pro 1920x1080@60Hz
VX600 Pro

VX1000 Pro

VX2000 Pro 3840%2160@60Hz

7.7.4.1 Play USB Files

Prerequisites

The U-DISK connector on the front panel is inserted with a USB drive which is successfully
identified.

Notes
None

Interface Example

v Playlist

1.bmp

2 bmp
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Description

In the playlist, select a file to play it and you can also stop the playback, play the previous or

next file as well as set the playback mode.

7.7.4.2 Configure Playback Parameters

Prerequisites

Notes

The U-DISK connector on the front panel is inserted with a USB drive which is successfully
identified.

Single-partition USB drive supported

File system: NTFS, FAT32 and exFAT

Max. width and height of media files

Width: 3840 pixels, height: 2160 pixels

Picture format: jpg, jpeg, png and bmp

Decoded image resolution: 3840%x2160 or lower

Video format: mp4, mkv, mov, avi, flv, m4v, mpg, mpeg, ts
Video coding: H.264, H.265, MPEG-2, MPEG-4

Max. video frame rate:

H.264: 3840%x2160@30fps, H.265: 3840x2160@60fps
MPEG-2/MPEG-4: 1920%1080@60fps

Max bitrate:

H.264/H.265: 100Mbps

MPEG-2/MPEG-4: 50Mbps

Audio coding: AAC, AC3, DTS, MP3, DVD, DVD_LPCM, MP2, OPUS
Audio sampling rate:

opus: 24kHz, 48kHz

Other formats: 22.05kHz to 94kHz
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Interface Example

v Playback Settings
Playback Mode
File Type

Playback Duration

Trans Effect (7)

Trans Duration
Auto Playback
Resume Playback

Capacity

Description

On the USB Playback Settings tab interface, configure the following parameters.

Parameter

Description

Playback Mode

The playback mode of the file

® Repeat: Play the files in the playlist in order. Once the playback of
the last file is completed, replay the first file.

® Repeat in Order: Play the files in the playlist in order. Once the
playback of the last file is completed, the screen will display a black
image and the playback will stop.

® Repeat One: Loop playback of the current file.

File Type

The type of the playback file
® Video
® Image

® All: Videos and images

B Note

After the file type is selected, only the file of the selected type will be
displayed in the playlist.

Playback Duration

The duration of the image playback

The value ranges from 1 to 60 and it defaults to 5. (Unit: s)

Trans Effect

The trans effect of the image

Supported trans effect: Ripple, zoom in, cut out, flip, blinds, H wipe, V
wipe, cube, dissolve, grid, swapping, scroll, fade in/out, twirl, heart

trans, doorway, perspective triangle, disappear, bounce, pinwheel and
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Parameter

Description

random.

Trans Duration

The trans duration of the image

The value ranges from 0.5 to 2 and it defaults to 0.5. (Unit: s)

Auto Playback

The auto playback switch

Set whether to automatically play the USB files after the device is
powered off and then power on with a USB drive inserted.

o @ 0n
If Resume Playback not enabled, replay the files in the playlist in

order; If enabled, replay the file being played before power failure

from the beginning.

o O Off

Resume Playback

Turn on or turn off the function.
o @ 0n
If a file is playing before the device power failure, enabling this

function allows to replay the file from beginning after the device is
powered on with a USB drive inserted.

o (Woff:

Replay the files in the playlist in order.

E Note

® Enabling Resume Playback will also activate the Auto Playback

feature at the same time.

® After Resume Playback is enabled, if the file being played before
power failure cannot be found, the files will be played from the

beginning of the playlist in order.

7.7.5 Set Audio

Prerequisites

None

Notes

None
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Interface Example (VX2000 Pro)

© | English- English

V €5 Devico 1
W Mosaic Source

MOSAIC

Vi UDisk

UDisk

v W Local

HOMI 1

HOMI2

HOMI3

HOMI4

HOMI5

HOMI6

oP

so1

Description

On the Programming interface, hover the mouse over and set the following parameters in

the popup menu.

Parameter Description

Output Set the output audio.

® | ayer n: Output the audio of the current layer input source. When
you switch the current layer input source, the audio will also be

changed.

® Audio In: Output the analog audio coming from an external audio
device. When you switch the current layer input source, the audio will
not be changed.

® Embedded audio of an input source: Output the fixed embedded
audio. When you switch the current layer input source, the audio will

not be changed.

The supported input source types include HDMI sources, DP sources,

and USB sources.

B Note

The input source audio of the layer 1 is output by default.

Volume The output volume

The value ranges from 0 to 100 and it defaults to 50%.
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Parameter

Description

® 0%: Mute

® 100%: Output at maximum volume.

B Note

Click below Volume to enable or disable the audio.

7.7.6 Set Input Source Audio

Prerequisites

None

Notes

None

Interface Example (VX2000 Pro)

" VS Devies t
o “/ 8 Mosaic Source

MOSAIC

~ i sk

U-Disk

M3
HOMI &

Hom 5

HOMI &

& FRZ

Englsh - English

Input Properties.

HOMI 2

oGP

 InfoFrame Ovemias
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Description

On the Programming interface, click the Input tab to display the input source list. Hover the
mouse over the desired input source and click @. In the popup menu, set the input source
audio to Embedded Audio or Audio In.

7.7.7 Configure Layer Properties

Select the desired layer, and then set the layer-related properties in the property area on the

right pane.

71.7.7.1 Configure Basic Properties

Configure the layer name, aspect ratio, position, size, as well as enabling the 3D effect.
Prerequisites

None
Notes

After enabling the 3D function on the Screen Settings page, 3D switches of all the layers will be
toggled on. If you want to use a 2D layer, please toggle off the 3D switch of the desired layer in

the property area of the Programming page.
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Interface Example

Aspect Ratio

v Position & Size

X 164

W 2006

Description

Video Layer

Custom

On the Basic tab interface, configure the following parameters.

Parameter | Description
Name The layer name
Aspect The ratio of the layer's width to its height
Ratio After the aspect ratio is changed, the height of the layer remains unchanged, and the
device automatically calculates its width.
X The horizontal starting position of the layer on the screen
The coordinates of the first pixel in the upper left corner of the screen are (0,0).
Y The vertical starting position of the layer on the screen
The coordinates of the first pixel in the upper left corner of the screen are (0,0).
w The horizontal size of the layer
The minimum width of a layer: 64 pixels
H The vertical size of the layer
The minimum height of a layer: 64 pixels
3D Turn on or turn off the function
o« @:0n
o (. off
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7.7.7.2 Crop Layer Sources

When there are black borders or other redundant info in the input source image, the required
picture can be retained through the cropping the input source, so as to improve the screen

utilization.
Prerequisites

A fine signal is connected to the input connector.
Notes

® The status and capacity of the cropped source remain consistent with the original one.

® The input cropping and 3D functions cannot be enabled at the same time.

Interface Example

v Layer Source Crop

Width
# 1920
Height

—. 1080

Reset

Description

On the Advanced tab interface, configure the following parameters.

Parameter Description
Layer Source Turn on or turn off the function.
Crop «@®:0n
o O off
X The horizontal start position of the cropped area relative to the original source
Y The vertical start position of the cropped area relative to the original source
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Parameter Description
Width The number of horizontal pixels (width) of the cropped area
Height The number of vertical pixels (height) of the cropped area

7.7.8 Configure OSD

Both the text OSD and image OSD are supported.

Prerequisites

Before setting a time OSD or weather OSD, please ensure that the device is connected to the

network to obtain the precise time and weather information.

Notes

® The OSD locates at the top and its priority cannot be adjusted.

® The text OSD and image OSD cannot be enabled together.

® The OSD function and remote control function cannot be enabled together.

OSD Type Descriptions

OSD Type Description
Text OSD ® Up to four text OSD presets are supported, and the preset 1 is selected by
default. The quantity of the text components are as follows.
- Static text OSD: 10
- Weather OSD: 2
— Time OSD: 2
— Dynamic text OSD: 1
® Does not support settings of the size and position of a text OSD.
E Note
The dynamic text OSD and other text components cannot be used together.
Image OSD ® Image gallery capacity: 75 MB
® Supported image OSD formats: PNG/JPG/JPEG/BMP
® Width and height limitations of a single image:
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OSD Type Description

- VX400 Pro/VX600 Pro/VX1000 Pro: Max width x Max height <
4096x1080, max width: 10240 pixels, max height: 8192 pixels

- VX2000 Pro: Max width x Max height = 4096x2160, max width: 16384
pixels, max height: 8192

Note: If the max width and height limitations are exceeded, you need to
scale or crop the image in Unico, and the width and height of the cropped

should be greater than 64 pixels.
® Supports setting of the image OSD position.
® Does not support setting of the image OSD size.

® Does not support setting of the image OSD opacity.

7.7.8.1 Configure Text OSD

Step 1 In the screen list on the left, select the desired screen.
Step 2 Click the OSD tab.

Step 3 Toggle the OSD switch to @D to enable the OSD function.

Figure 7-32 Enable OSD

Step 4 Click the Text OSD tab, and drag the desired OSD preset to the editing area. The OSD preset 1
is selected by default.

OSD preset-related operations:
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Step 5

Step 6

Step 7

Step 8

Step ¢

® Change the OSD preset name: Hover the mouse over the desired OSD preset, and then click
that appears. Enter a new preset name, and then click elsewhere in the interface to

complete the preset name change.

® C(Clear the OSD preset: Click at the top right corner of the desired preset, and then click

Yes in the popup dialog box to clear OSD components saved in the selected preset.

® | ock/Unlock the OSD preset: Click m at the top right corner of the desired preset to lock

or unlock the preset.

® Save the OSD preset: Click El at the top right corner of the desired preset, and then select

another preset to save the OSD components from the original preset to the selected one.
On the right Layer pane, drag the -, -, H or - icon to add a static text
OSD, dynamic text OSD, weather OSD or time OSD.
Set the position and size of the OSD layer.

® X: Set the horizontal distance from the top left corner of the OSD layer to that of the screen.
® Y: Set the vertical distance from the top left corner of the OSD layer to that of the screen.
® W: Set the OSD layer width.

® H: Set the OSD layer height.
Click the created OSD layer to display the OSD configuration area on the right.

Set the related parameters of the added OSD component. For the parameters of each OSD

component, please refer to the following descriptions.

Click Apply at the top right corner to complete the settings and display the set OSD on the

screen.

E Note

Select the desired OSD components, and then click shown at the top right corner. In the
popup dialog box, click Yes to delete the selected OSD component.
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Static Text OSD

Figure 7-33 Interface example

v Static Text OSD

Welcome

Font Settings I Fonts

Noto Sans CJK SC Bold 100

B I A ¢ © IS 1.5%

Text Direction Horizontal
Text Position & Size
X 2854

W 540

~ Common Properties

Color

Calor

Opacity

B ———— IR0
Background Color

Color

Opacity

Table 7-3 Parameter descriptions

Area Parameter Description

Text area | - Enter the text OSD content.

The static text OSD supports multi-line display. You can press

Enter on the keyboard to have line breaks.

Character | Font Settings Select the desired text font from the drop-down list.

Library ® Delete single/multiple fonts: Click Library. In the popup window,
check the boxes next to the desired fonts, and then click Delete

to delete the selected fonts.

® Delete all fonts: Click Library. In the popup window, check the
box next to Library, and then click Delete to delete all fonts.

® Add fonts: Click Library. In the popup window, click New to add
the fonts saved in the local computer to the font library.

Font size : Set the font size. The value ranges from 8 to 512 px and it
defaults to 100 px.
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Area Parameter Description

Font style o E: Make the text bold or not.
. : Italicize the text or not.

4 : Underline the text or not.

Character spacing : Set the spacing between characters. The value ranges from 0
to 1000 px and it defaults to 0 px.

Row spacing : Set the spacing between rows. This parameter is available
when there are multiple rows. The value ranges from 0 to 1000 px
and it defaults to 0 px.

Alignment method Set the text alignment method.

4 E: Align the text content with the left margin of the display
area.

o E: Center the text content in the display area.

o E: Align the text content with the right margin of the display
area.

o E: Align the text to the top of the display area.

o =: Center the text vertically to the display area.

o E: Align the text to the bottom of the display area.

Layout Select the text layout direction from the drop-down list.

The supported options include Horizontal, From Right (Vertical)
and From Left (Vertical).

Text position and Set the position and size of the OSD component.

size ® X: Set the horizontal distance from the top left corner of the OSD

component to that of the screen.
® Y: Set the vertical distance from the top left corner of the OSD
component to that of the screen.
® W: Set the OSD component width.
® H: Set the OSD component height.
Common | Text color Click the color block icon next to Select Color to open a window
properties where you can select the desired color or customize your own
color. Drag the slider or enter a value in the text box to adjust the
opacity. The opacity ranges from 0% (totally transparent) to 100%
(nontransparent).

Background color Toggle on/off Background Color to enable or disable the

background color settings.
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Area Parameter Description

Click the color block icon next to Select Color to open a window
where you can select the desired color or customize your own
color. Drag the slider or enter a value in the text box to adjust the
opacity. The opacity ranges from 0% (totally transparent) to 100%
(nontransparent).

Dynamic Text OSD

Figure 7-34 Interface example

~ Dynamic Text OSD

Welcome

Font Settings 2 Fonts

Noto Sans CJK SC Bold [ 100

B I U YA 0 px?

Speed 1

Direction From Right
Text Position & Size

X 2932

W 540

~ Common Properties

Color

Color
Opacity
D ————— IR

Background Color

Color

Opacity

Table 7-4 Parameter description

Area Parameter Description
Textarea | - Enter the text OSD content.
Character | Font Settings Select the desired text font from the drop-down list.
Library ® Delete single/multiple fonts: Click Library. In the popup window,

check the boxes next to the desired fonts, and then click Delete

to delete the selected fonts.

® Delete all fonts: Click Library. In the popup window, check the
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Area Parameter Description
box next to Library, and then click Delete to delete all fonts.
® Add fonts: Click Library. In the popup window, click New to add
the fonts saved in the local computer to the font library.
Font size : Set the font size. The value ranges from 8 to 512 px and it
defaults to 100 px.
Font style o E: Make the text bold or not.
. : Italicize the text or not.
4 : Underline the text or not.
Character spacing : Set the spacing between characters. The value ranges from 0
to 1000 px and it defaults to 0 px.
Speed Set the text scrolling speed. The value ranges from 0 (static) to 10
(fastest).
Direction Set the text scrolling direction.
® From Left: The text scrolls from right to left in the display area.
® From Right: The text scrolls from left to right in the display area.
Text position and Set the position and size of the OSD component.
size ® X: Set the horizontal distance from the top left corner of the OSD
component to that of the screen.
® Y: Set the vertical distance from the top left corner of the OSD
component to that of the screen.
® W: Set the OSD component width.
® H: Set the OSD component height.
Common | Text color Click the color block icon next to Select Color to open a window
properties where you can select the desired color or customize your own
color. Drag the slider or enter a value in the text box to adjust the
opacity. The opacity ranges from 0% (totally transparent) to 100%
(nontransparent).
Background color Toggle on/off Background Color to enable or disable the
background color settings.
Click the color block icon next to Select Color to open a window
where you can select the desired color or customize your own
color. Drag the slider or enter a value in the text box to adjust the
opacity. The opacity ranges from 0% (totally transparent) to 100%
(nontransparent).
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Weather OSD

Figure 7-35 Interface example

v OSDLayer
Type
Layer Position & Size

X | 256

Vv Weather OSD
Weather Settings
Location
Refresh 10

Language English
Temperature Unit
Content
Weather Temperature
Wind Speed Humidity

Current
Temperature

Custom Tab

Layout

Y

Display Mode Single Line: Multi-Line

Spacing

text

px "

Y

Font Settings I Fonts

Alibaba PuHuiTi REE...

B I U VAlo

Text Position &
X | 256

W | 1000

v Common Properties

Color

Color

Opacity

Background Color

Color

Opacity
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Table 7-5 Parameter description

Area

Parameter

Description

Weather

settings

Location

Click u to open the map window, where you can select the
desired location or enter the address. Click OK to complete the

settings.

Refresh

Set the automatic refresh interval for the weather information. The

value ranges from 1 to 1440 minutes and it defaults to 10 minutes.

Language

Set the text language. The supported options include English and
Chinese.

Temperature Unit

Set the temperature unit. The supported options include °C and °F.

Content

Set the content to be displayed in the weather OSD.

Check the box next to the desired content to display it in the
weather OSD. You can also click Custom Tab to edit the default

display content.

Layout

Display mode

Set the display mode of the weather OSD.
® Single Line: Display all items in single line.

® Multi-Line: Display each item in single-line.

Spacing

Set the spacing between each selected content in Single Line
display mode or set the spacing between rows in Multi-Line

display mode.

Text

Font Settings

Select the desired text font from the drop-down list.

Library

® Delete single/multiple fonts: Click Library. In the popup window,
check the boxes next to the desired fonts, and then click Delete

to delete the selected fonts.

® Delete all fonts: Click Library. In the popup window, check the

box next to Library, and then click Delete to delete all fonts.

® Add fonts: Click Library. In the popup window, click New to add

the fonts saved in the local computer to the font library.

Font size

: Set the font size. The value ranges from 8 to 512 px and it
defaults to 100 px.

Font style

. E: Make the text bold or not.
. : Italicize the text or not.

° : Underline the text or not.

Character spacing

: Set the spacing between characters. The value ranges from 0
to 1000 px and it defaults to 0 px.
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Area Parameter Description

Row spacing E: Set the spacing between rows. This parameter is available
when there are multiple rows. The value ranges from 0 to 1000 px

and it defaults to 0 px.

Alignment method | e E: Align the text content with the left margin of the display

area.

4 E: Center the text content in the display area.

Text position and Set the position and size of the OSD component.

size ® X: Set the horizontal distance from the top left corner of the OSD
component to that of the screen.

® Y: Set the vertical distance from the top left corner of the OSD

component to that of the screen.
® W: Set the OSD component width.
® H: Set the OSD component height.

Common | Text color Click the color block icon next to Select Color to open a window
properties where you can select the desired color or customize your own
color. Drag the slider or enter a value in the text box to adjust the
opacity. The opacity ranges from 0% (totally transparent) to 100%

(nontransparent).

Background color Toggle on/off Background Color to enable or disable the

background color settings.

Click the color block icon next to Select Color to open a window
where you can select the desired color or customize your own
color. Drag the slider or enter a value in the text box to adjust the
opacity. The opacity ranges from 0% (totally transparent) to 100%
(nontransparent).
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Time OSD

Figure 7-36 Interface example

v OSD Layer

Type 0SD Layer

Layer Position & Size

X | 163

v Time OSD
Configuration
Time Zone (UTC+08:00) AsiafShang...

Time Ofizet 0

Content
Language English
Date
Year Format YYYY

Date Format YYYYMWDD

Time Type Local Time
Week

Time

24-Hour

Time Format HH:MM:55

Layout w

Display Mode Single Line Multi-Line

www.novastar.tech

181



NOVASTAR VX Pro Series All-in-One Controller User Manual

Text v
Font Settings ©1 Fonts

Noto Sans CJKSCBold  ~| T | 100

B I YA o =

Text Position & Size

X | 163

v Common Properties

Color

Color

Opacity

Background Color

Color

Opacity

Table 7-6 Parameter descriptions

Area Parameter Configuration
Configuration | Time zone Select the time zone from the drop-down list.
Time offset Set the time offset value. The value ranges from -2 to +2 (unit:
hour).
Content Language Set the text language. The supported options include English
and Chinese.
Date Display or hide the date.

o D Display the date.
o (I Hide the date.

Year format Set the year format. The supported options include YYYY (four-
digit year) and YY (two-digit year).

Date format Set the date format.
Time type The supported options include Local Time and Network Time.
Week Display or hide the week.

o IO Display the week.
o (- Hide the week.

Time Display or hide the time.
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Area

Parameter

Configuration

o D Display the time.
o (I Hide the time.

24-hour

Display the time with 24-hour format or not.
o I Display the time with 24-hour forma
e Display the time with 12-hour forma

Time Format

Set the time format.

Layout

Display mode

Set the display mode of the time OSD.

® Single-Line: Display the date, day of the week and time in
single-line.

® Multi-Line: Display each item in single-line.

Spacing

Spacing: Set the spacing between the date, day of the week and
time in Single Line display mode or set the spacing between

rows in Multi-Line display mode.

Text

Font Settings

Select the desired text font from the drop-down list.

Library

® Delete single/multiple fonts: Click Library. In the popup
window, check the boxes next to the desired fonts, and then
click Delete to delete the selected fonts.

® Delete all fonts: Click Library. In the popup window, check the
box next to Library, and then click Delete to delete all fonts.
® Add fonts: Click Library. In the popup window, click New to

add the fonts saved in the local computer to the font library.

Font size

: Set the font size. The value ranges from 8 to 512 px and it
defaults to 100 px.

Font style

. E: Make the text bold or not.
o : Italicize the text or not.

. : Underline the text or not.

Character spacing

: Set the spacing between characters. The value ranges from
0 to 1000 px and it defaults to 0 px.

Row spacing

: Set the spacing between rows. This parameter is available
when there are multiple rows. The value ranges from 0 to 1000
px and it defaults to 0 px.

Alignment method

] E: Align the text content with the left margin of the display

area.

4 E: Center the text content in the display area.
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Area Parameter

Configuration

Text position and

size

Set the position and size of the OSD component.

® X: Set the horizontal distance from the top left corner of the

OSD component to that of the screen.

® Y: Set the vertical distance from the top left corner of the OSD

component to that of the screen.
® W: Set the OSD component width.

® H: Set the OSD component height.

Common Text color

properties

Click the color block icon next to Select Color to open a window
where you can select the desired color or customize your own
color. Drag the slider or enter a value in the text box to adjust
the opacity. The opacity ranges from 0% (totally transparent) to

100% (nontransparent).

Background color

Toggle on/off Background Color to enable or disable the
background color settings.

Click the color block icon next to Select Color to open a window
where you can select the desired color or customize your own
color. Drag the slider or enter a value in the text box to adjust
the opacity. The opacity ranges from 0% (totally transparent) to

100% (nontransparent).

7.7.8.2 Configure Image OSD

Add Image OSDs

Step 1 In the screen list on the left, select the desired screen.

Step 2 Click the OSD tab.

Step 3 Toggle the OSD switch to @ to enable the OSD function.
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Figure 7-37 Enable OSD

Step 4 Click the Image OSD tab to enter the image OSD configuration page.

Step 5 Click to open a window where you can select the desired OSD images.
Step 6 Click Open to upload the selected images.

Step 7 Click and drag the uploaded image to the editing area to add an image OSD.

Figure 7-38 Add image OSDs

Step 8 Set the position and size of the OSD layer.

® X: Set the horizontal distance from the top left corner of the OSD layer to that of the screen.
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® Y: Set the vertical distance from the top left corner of the OSD layer to that of the screen.

Delete Gallery Images

® Delete a single image: Hover the mouse over the desired image, and then click 9 In the

popup dialog box, select Yes to delete the selected image.

® Delete multiple images: Click Edit, and then check the boxes next to the desired image or

check the box next to All. After selection, click and select Yes in the popup dialog box.

Export Gallery Images

Click Edit, and then click . In the popup window, select the saving path to export all images

in the gallery to your local computer.

7.7.9 Manage Presets

To manage the presets, click Preset on the right side of the Programming interface and

perform the corresponding actions as needed.

Save Presets

Step 1 In the screen list on the left, select the desired screen.

Step 2 On the Preset tab interface, click Add at the bottom, and the system will automatically display

the preset number binding window.
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Figure 7-39 Bind presets (VX2000 Pro)

Commecton
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HOMI6

%)

Englsh - English

Screen Setngs  Programming

Step 3 In the preset number binding window, select the desired key number to save the current layer

information to the preset.

One key number corresponds to one preset. The name of the save preset: Preset X ("X" refers to

the bound key number.)

Switch Display Style of Preset List

(] E: List view

. : Graphical view

Load Presets

In the preset list, select the desired preset to load it.
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After the preset is successfully loaded, the B icon will be displayed at the top left of the

preview area.
Rename Presets

® |nthe list view mode (E), hover the mouse over the preset, and then click . Enter a new

name and then click elsewhere to make the change take effect.

® |n the graphical view mode (, hover the mouse over the preview area, and then click @
that appears. In the popup menu, select Rename and enter a new name, and then click

elsewhere to make the change take effect.

View Preset Details

® |n the list view mode (E), hover the mouse over the preset, and then click E that appears.

In the popup window, you can view the name and screen of the preset.

® |n the graphical view mode (, hover the mouse over the preview area, and then click @
that appears. In the popup menu, select Details to show the popup window where you can

view the name and screen of the preset.

Set Preset Switching Effect

Click ﬂ and then select the desired transition effect in the popup menu. The supported

options are as follows.
® Cut: Switch one preset to another with no transition effect.
® Fade: Switch one preset to another with a fade effect.

After selecting Fade effect, click OK in the popup dialog box. Additionally, you can set the

transition duration. The value ranges from 1s to 3s and it defaults to 2s.

E Note

e The fade effect takes effect on presets with less than 7x SL layers only.

e Only the VX2000 Pro supports setting of the preset switching effect.

Delete Single Presets

® |n the list view mode (E), hover the mouse over the preset, and then click that appears.

In the popup window, select Yes to delete the preset.
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® |n the graphical view mode (, hover the mouse over the preview area, and then click @
that appears. In the popup menu, select Delete, and then select Yes in the popup dialog box.

Delete Multiple Presets

Click Operation, check the boxes next to the desired presets or check Select All, and click .
In the pop-up dialog box, select Yes.

7.8 Tools
7.8.1 Maintenance

7.8.1.1 Maintain Devices

In the menu bar, navigate to Tools > Maintain. Select the Device tab and the target devices,

and then do the following as required.

Figure 7-40 Device maintenance (VX2000 Pro)

Update

0 Caution

e During the update process, power-off and all operations are NOT allowed.
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e Before updating the device, please connect the control PC and device using an Ethernet cable.

USB connection is not allowed for update.

Step 1 Click Update.

Step 2 In the pop-up dialog box, select the update file (.img) and click OK.
Step 3 Confirm the devices to be updated, and click the Update button.

Step 4 In the pop-up dialog box, click Yes and wait until the update completes.

Step 5 After the update completes, click OK.

Restart

Click Restart. In the displayed dialog box, click Yes to restart the device.

Factory Reset

0 Caution

e Please do this with great caution.
e The reset action does not affect the device firmware version.
e Power-off is NOT allowed during the reset process.

e The device will restart automatically after the reset is completed.

Click Factory Reset. In the pop-up dialog box, select Keep user data, Retain IP only or Reset
all, and then click OK.

® Retain user data

Retain the input EDID, imported files, language, device name, device IP, belonged project

and restore points.
® Retain IP only

Only retain the device IP address and reset other parameters to factory defaults.
® Reset all

Reset all parameters.
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Figure 7-41 Factory reset

Factory Reset

Please select a factory reset method:

Retain user data

Retain IP only

Reset all

Export Logs

Click Export Log. In the dialog box that appears, select a path and click Save to save the device
logs to local computer.

Device Diagnostics

Click Diagnostics. After the diagnostics completes, you can view the test result and take

necessary measures as required.

Figure 7-42 Device diagnostics (VX2000 Pro)
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7.8.1.2 Maintain Cabinets

In the menu bar, navigate to Tools > Maintain. Select the Cabinet tab and the target cabinets,

and then do the following as required.

Figure 7-43 Maintain cabinets

7 Eagisn-Engish

View Cabinet Information

View the cabinet online status, cabinet manufacture, cabinet model, receiving card model,
receiving card firmware, associated device, card (only applicable for card-based device), device

IP and cabinet position.

View Receiving Card Firmware

Click Details to view the FPGA and MCU versions of the receiving card.

Cabinet Painter

Click Painter and select one or more cabinets so that other cabinets can have the same

firmware program and configuration file as the selected cabinet.

Update Cabinet Configuration Files

Select one or multiple cabinets, and then click Update.

www.novastar.tech 192



NOVASTAR VX Pro Series All-in-One Controller User Manual

Figure 7-44 Update cabinets

Update

Update Method Cabinet Library Firmware Program Configuration File Image Qualty File

Upcate Coment (3 mport )

Cabinet Model Version Resolution Chip

1925216 px ICN2053

256x256 px

Select the desired update method in the popup window.

Select an existing file: Choose an NCP/rcfgx file from the popup window and click Update.

Import a new file: Click Import to upload an NCP/ file. You can select the import objects
(multiple selections are possible) from Local pack or Device pack. Once the upload is
complete, return to the Update interface, select the imported NCP/rcfgx file, and click
Update.

Firmware Program: Update the firmware version of the receiving card. Upload a file in image

format, and then click Update.

Configuration File: Update the cabinet configuration file. Upload an NCP/ rcfgx file, and then
click Update.

Image Quality File: Import the adjustment parameters of the image quality. Upload a file in

vglex format, and then click Update.

E Note

The supported cabinet update method depends on the receiving card model.

Restart Cabinet

Click Restart. In the popup dialog box, click OK to restart the cabinet.

Refresh Cabinet Info

Click Refresh to refresh the cabinet information.

7.8.2 Configure Device Backup

Device backup allows you to set the backup relationship between two devices. You can set one

of the devices as the primary device or the backup device. When the primary device has a
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problem or the primary device's Ethernet cable fails, the backup device will take over the
responsibilities of the primary device seamlessly and continue to work well to ensure the LED

screen will not go black.

Prerequisites

Notes

Before creating a backup relation, make sure that both the primary and backup devices are

on the same LAN.

In a backup relation, the models and device versions of the primary and backup devices must

be the same.

You have three options to create a backup relation: NovaLCT, Unico, or the device LCD
menu. However, be aware that these methods do not synchronize with each other. Using
more than one can lead to data problems. To prevent issues, choose only one method for
setting up your backup. If you do mix them, you'll need to reset the device to factory settings

and start over with just one method.

In the device backup mode, the quantity of the cabinets loaded by each Ethernet port on
both the primary and backup devices must be the same, but their data flow must be in a

reversed way.

Operation Procedure

Step 1

In the menu bar, go to Settings > Device Backup.

Step 2 In the pop-up window, click Add to add a backup relation.
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Figure 7-45 Add backup relations (VX2000 Pro)

Device Backup

Primary Device Backup Device Firmware Version Action

Device 1

Delete

Step 3 Select the primary and backup devices from the drop-down lists respectively.

After the action completes, the firmware versions of the primary and backup devices will be
displayed.

Step 4 Click OK to complete the backup relation settings.

Step 5 (Optional) Click Delete to delete the desired backup relation.

7.8.3 Manage Cabinet Library

In the menu bar, go to Tools > Cabinet Library. Do the followings as needed to manage the

cabinet library files.
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Progat 1 Englsh - English

Cabinet Library

+ Add
Locai Pack Device Pack (Device 1)
Name ¥ Resolution ¥ T i Name

1902216 px 1ol o 192:216

192%216

Cabinet Info Module Info

ManuraCurer = voges Diver Chip:

- weignt :]

192%216 px owe 169.16W

Active Low

« Collapse

Upload Cabinet Files

Step 1 Click Add and select the cabinet type in the displayed window.
The cabinet types are as follows.
® Cabinet File

Figure 7-46 Cabinet files

Type Cabinet File (NCP/rcfgx)
Virtual Cabinet

Import File Local Pack Device Pack

Import Objects (4, Upload )

® Virtual Cabinet: If Virtual Cabinet is selected, you need to configure the parameters such as

cabinet name, resolution width and height.
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Figure 7-47 Virtual cabinets

Add

Type Cabinet File (NCP/rcfgx)
Virtual Cabinet

Import File Local Pack Device Pack

Name Enter here

Res W Enter hempx 7 Enter hemp

Manufacture| Enter here

Model Enter here Pitch Enter henen
Size W Enter henen 3 SizeH Enter henen

Weight | Enter hereg Power  Enter hereV

Click to collapse ~

Step 2 Select the NCP/.rcfgx file to be imported from the local computer and click Upload.

After the file is selected, you can click Delete to delete the uploaded file.

Export Cabinet Files

Step 1 Select one or more files on the Cabinet Library interface and then click Export.

For batch export, multiple files will be compressed as a .zip file and exported.

Step 2 Select a local directory and click Save.

Sync Cabinet Files

® Sync cabinet files between devices

1) Select the files to be synced (multiple files can be selected), and click Sync Cabinet

Library.

2) On the displayed window, select the devices to which the files are synced (multiple

devices can be selected).
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Figure 7-48 Sync cabinet files (VX2000 Pro)

Sync Cabinet Library

Device Name IP Address

Device 1 192.168.0.10

3) Click OK.

View Cabinet and Flash Info

Select a cabinet file, and the information about all the cabinets that use this cabinet file will be

displayed.

Cabinet Info

Manufaciurer. - -

= 21528kg

192x216 px ower. 169 18W

7.8.4 Device Discovery

Module Info

Driver Chip: ICN2053 Module
Resolution:

96108 px

27

Horizontal
Amangement

OE Polarity: Active Low

Add devices across different network segments or non-discoverable devices via IP addresses.

Prerequisites

None

Notes

None
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Interface Example

Device Discovery

Devices within the same subnet are automatically discovered. For resiricied
networks or cross-subnet management, please manually add IP addresses.

P

Configuration

Navigate to Tools > Device Discovery from the menu bar. In the popup window, click Add to
manually input the device IP. Once added, click OK.

7.8.5 Test Tool

Utilize test patterns to assess display performance and pinpoint issues.

Prerequisites

For better software operation when the display window is large, it is recommended to prepare

an extended display for viewing test patterns.

Notes

The test tool only supports Windows operating systems.
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Interface Example

[ Test Tool Window1 |+
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Navigate to Tools > Test Tool from the menu bar to open the test tool configuration interface.

Please refer to the Test Tools User Manual for specific operations.

7.9 Software Settings

7.9.1 Switch Ul Language

Select the desired language from the drop-down list at the top right corner to switch the Ul

language.

7.9.2 Change Skin

In the upper right corner of the interface, click to select the desired skin.
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Figure 7-49 Change skin

7 English - English

v

Cosmic Gray Midnight Black

7.9.3 Export Logs

In the menu bar, navigate to Settings > Export Log to export the logs of the Unico software.

7.9.4 Configure Preferences
In the menu bar, navigate to Settings > Preferences. Turn on the desired features (checked "v")
or off (unchecked).

® Screen Resources: Show the layer resources on the Programming interface if enabled.

® | ock Aspect Ratio: Lock the aspect ratio when adjusting the width and height of new layers
if enabled.

7.9.5 View Software Info

In the menu bar, go to Help > About Us to view the software-related info.

7.9.6 Check User Manual

In the menu bar, navigate to Help > User Manual to scan the QR code or click the link provided

to access the latest product documentation.
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8 Appendix

8.1 Loading Capacity Calculation Method in Low Latency
Mode

In low latency mode, the effective loading capacity of a single Ethernet port will change
according to the coordinates of the connected cabinets. This chapter introduces how to

calculate the effective loading capacity of an Ethernet port in low latency mode.
Calculation Formula

Max loading capacity of a single Ethernet port = (1 - (Y / H)) x TOTAL
® Y: The minimum Y coordinate of all cabinets loaded by a single Ethernet port
® H: The total height of the current canvas

® TOTAL: The maximum loading capacity of a single Ethernet port in common mode, fixed to
650,000.

Calculation Example

As shown in the figure below, the minimum Y coordinate of the cabinets connected to an
Ethernet port is 1200 (Y = 1200), the total height of the canvas is 2160 (H = 2160), and the max
loading capacity is 650,000 (TOTAL = 650,000). Based on the calculation formula, the maximum
loading capacity of this Ethernet port in low latency mode is:

(1-(1200/2160)) x 650,000 ~ 0.556 x 650,000~ 361,400
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E Note

The loading capacity of the Ethernet port is only related to the minimum Y coordinate of the

connected cabinets and has nothing to do with the X coordinate.
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9 Copyright

Copyright © 2026 Xi'an NovaStar Tech Co., Ltd. All Rights Reserved.

No part of this document may be copied, reproduced, extracted or transmitted in any form or by any means
without the prior written consent of Xi'an NovaStar Tech Co., Ltd.

Trademark
NDVQSTAR is a trademark of Xi'an NovaStar Tech Co., Ltd.

Statement

Thank you for choosing NovaStar's product. This document is intended to help you understand and use the
product. For accuracy and reliability, NovaStar may make improvements and/or changes to this document at
any time and without notice. If you experience any problemsin use or have any suggestions, please contact us
via the contact information given in this document. We will do our best to solve any issues, as well as evaluate
and implement any suggestions.

Official website
www.novastar.tech

Technical support
support@novastar.tech
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